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Preface EEC compatibility

is product complies with the re-
irements of the Council Directives
/336/EEC and 73/23/EEC amend-
by 93/68/EEC on the approxima-
n  o f  t h e  l aws  r e l a t i n g  to
ctromagnetic compatibility and
 voltage.

As an Energy Star Partner, Oki
has determined that this product
meets the Energy Star guidelines
for energy efficiency.

ownload.
Every effort has been made to ensure that the informa-
tion in this document is complete, accurate, and up-to-
date. Oki assumes no responsibility for the results of er-
rors beyond its control. Oki also cannot guarantee that
changes in software and equipment made by other man-
ufacturers and referred to in this guide will not affect
the applicability of the information in it. Mention of
software products manufactured by other companies
does not necessarily constitute endorsement by Oki.

Copyright 1999 by Oki. All rights reserved.

Oki is a registered trademark of Oki Electric Industry
Company Ltd.

Energy Star is a trademark of the United States Envi-
ronmental Protection Agency.

Microsoft, MS-DOS and Windows are registered trade-
marks of Microsoft Corporation.

Apple, Macintosh, Mac, MacOS and True Type are reg-
istered trademarks of Apple Computer Corporation.
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ot use the printer near water, or spill liquid
y kind into it.

e sure that the power source matches the rat-
sted on the back of the printer. If you are not
 check with your dealer or with your local
r company.

 printer has an earthed plug as a safety fea-
and will only connect to an earthed outlet. If
lug cannot be connected to a power outlet,
it is possible that the power outlet is of the
, non-earthed type. Contact an electrician to
 the power outlet replaced. Do not use an
ter to defeat the earthing.

void damaging the power cable, do not put
ing on it or place it where it will be walked
f the cable becomes damaged or frayed,
ce it immediately.

 extension cable or power strip is being used
the printer, make sure that the total of the
rage rating required by all the equipment is
than the rating of the extension cable or
r strip. The total ratings of all equipment

ownload.
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Safety instructions

This printer has been carefully designed to give years of
safe, reliable performance. As with all electrical equip-
ment, however, there are a few basic precautions that
should be taken to avoid personal injury or damaging
the printer:

• Read this setup guide carefully and save it for
future reference.

• Read and follow all warning and instruction
labels on the printer itself.

• Disconnect the printer before cleaning. Use only
a damp cloth. Do not use liquid or aerosol clean-
ers to clean the printer.

• Place the printer on a firm, solid surface. If the
printer is placed on something unsteady, it may
fall and become damaged or injure someone. If
the printer is placed on a soft surface, such as a
rug, sofa, or bed, the vents may become blocked
causing the printer to overheat.

• Do not put the printer on or near a heat source,
such as a radiator or heat register. Keep it out of
direct sunlight.  Allow enough room around the
printer for adequate ventilation and easy access.

• Do n
of an

• Mak
ing li
sure,
powe

• This
ture 
this p
then 
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have
adap

• To a
anyth
on. I
repla

• If an
with 
ampe
less 
powe
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iv User’s Guide

plugged into the outlet should not exceed 13
amperes.

If anything happens that indicates that the printer is not
working properly or has been damaged, disconnect the

er source and contact your dealer.
e things to look for:

e or plug is frayed or damaged.

n spilled into the printer, or it has
 water.

 been dropped, or the cabinet is

s not function normally when fol-
ating instructions.

ownload.
• The power outlet into which the printer is con-
nected must remain accessible at all times.

• Opening any cover may expose hot surfaces.
These are clearly labelled. Do NOT touch them.

• Do not insert anything into the ventilation slots
on the printer; you could get a shock or cause a
fire.

• Aside from the routine maintenance described in
the user’s guide, do not try to service the printer
yourself. Opening a cover may expose you to
shocks or other hazards.

• Do not make any adjustments other than those
outlined in the user’s guide as damage may be
caused to the printer.

printer from the pow
These are some of th

• The power cabl

• Liquid has bee
been exposed to

• The printer has
damaged.

• The printer doe
lowing the oper
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Chapter 1 - Introduction

Introduction

Thank you for your purchase of the OKI DP-5000 Pho-
to Quality Colour Printer. This printer represents the
most recent advances in printing quality and technolo-
gy. Whether you need a printer for your Windows PC,
your Macintosh or the new iMac computer, this printer
is the solution you have been looking for. In addition to
the standard features listed in this Chapter we can offer
a number of optional devices which expand machine
functions and further support your communication
needs. The available options include:

• Macintosh SCSI Interface Module

• USB Interface Kit for iMac and PC with Windows 98

• Dye Sublimation Upgrade Kit ( for photographic 
printing)
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Features

ownload.
The following is a summarised list of the many standard
features offered by your new printer: 

• Variable-dot 2400 dots-per-inch printing resolu-
tion.

• Seven-colour ink capacity, the most challenging
printing tasks are easily accomplished.

• Fully compatible with all of the standard inks and
foil colours.

• Fade-proof, smear-proof, and waterproof print-
ing.

• Ability to print on any paper using our VPhoto
Primer cartridge. 

• Our Econo Black cartridge can be used again and
again, for the lowest-cost black and white print-
ing. 

• Reversable finish cartridge enabling the cartridge
to have a more extended life. 

• Option to add dye sublimation printing. With a
simple upgrade kit, you can have true continuous-
tone photographic-quality printing at your finger-
tips. 
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ove the three pieces of tape (1) from the out-
of the printer before using.

ont cover

 the front cover to remove the inside pack-
aterial.

pen the front cover (1), push the front cover
se button (2) to release the internal lock.
ly lower the front cover with your hand.

ove the two pieces of carriage packing mate-
1) from inside the printer.

 down on the release lever (2).

2
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Preparing your printer

Removing package contents

1. Lift the printer out of its container box. Remove
the packing materials from inside and outside the
printer.

Caution
The printer is shipped with tape, spacers, and other
packing materials to prevent delicate parts from being
damaged while in transit. Remove these packing materials
before using the printer. Damage to the printer or
malfunction may occur if the printer is used while these
packing materials are still present.

2. Rem
side 

Opening fr

1. Open
ing m

2. To o
relea
Gent

3. Rem
rial (

4. Press

1

1
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5. Remove the tape (3) from the metal frame, and
move the smaller packing piece (1) to the left.

C
O
m

C
D
th
pr
m
ge
lo

 after removing the carriage pack-

cover, never slam it shut. The ink
 dislodged and damage to the

packing material and reading the
see page iii), choose a location

, firm surface for your printer.  Try
h are subject to extremes of heat,
mp. Also, choose a location from

1

4

3
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6. Remove the other tape (3) from the carriage

aution:
perating the printer without first removing the packing
aterials may damage the printer.

aution:
o not remove the white pad (1) or the cleaning pad (2) at
e left end of the platen (3). They are there to clean the
int head. Removing them can cause the printer to
alfunction. The cleaning pad can be replaced when it
ts dirty. Do not touch the cover open sensor (4), which is
cated on the left side of the printer.

Closing front cover

Close the front cover
ing material.

Caution:
When closing the front 
cartridges can become
printer may result.

Locating printer

After removing the 
safety precautions (
which offers a stable
to avoid places whic
cold, sunlight and da

2
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which you can run the power cables safely to suitable
nearby connection points.

Installing output paper tray

Place the printer on the output paper tray (1) as shown
below. During printing, extend the paper tray. The out-
put paper tray will hold up to 100 sheets of paper.

1
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Printer functions

F

artridges. Open the front cover
th hands.

he front cover protects the internal
 the printer. The cover is always
rinting.

t - Paper exits the printer through

rinter while it is operating. Injury
the front cover while the printer is

5

6

ownload.
The following paragraphs explain the name and func-
tion of each part of the printer.

ront view of printer

1. Sheet feeder - Paper can fed into the printer either
automatically or manually. Place a stack of not
more than 100 sheets (plain laser paper) for auto-
matic feed. In manual feed, insert a single sheet at
a time.

2. Front cover release button - Pressing this button
opens the front cover. The front cover will need to
be opened when there is a paper jam or when

changing ink c
gently, using bo

3. Front cover - T
mechanisms of
closed during p

4. Paper output slo
this slot.

Caution:
Never reach inside the p
may result. Do not open 
running.

1

2

3
4

7
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ssory connector - This connector is used to
ect an optional dye sublimation key or Mac-
h interface module to the printer. Make sure
remove the rectangular plastic connector
r before connecting either of these options.

r feed switch - This switch sets the paper
ng method to automatic feed mode or man-
ed mode.

r socket - The power cable connects to the
r socket.

 of printer with Macintosh 
odule

switches - The DIP switches are used to set
CSI device number for the printer.

3

4

ownload.
Chapter 1 - Introduction

5. Paper stopper - This stopper prevents the paper
from rising when the small size media is set verti-
cally for printing.

6. Paper support - The paper support holds the
loaded paper upright. To extend the paper sup-
port, pull up on the top edge.

7. Paper feed guide - This guide feeds the paper into
the printer. Set the adjustable guide on the left to
match the paper size being used.

Rear view of printer

1. Parallel interface connector - The printer cable is
connected to the parallel interface connector.

2. Acce
conn
intos
you 
cove

3. Pape
feedi
ual fe

4. Powe
powe

Rear view
interface m

1. DIP 
the S

1

2

3

4

1

2
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8 User’s Guide

2. SCSI connector - The SCSI connectors are used
for connecting to the Macintosh computer and/or

In

needed for a particular printing job. A maximum
of seven ink cartridges is allowed.

 carriage automatically picks up
 cartridge needed for printing and
 printing location. The carriage
e print head.

 This lever, located to the right of
d platen, is used to clear paper

 release lever down to remove the
 When you close the front cover,
tomatically go back to its original

e print head prints the characters.
uch the underside of the head.

4

ownload.
other SCSI devices.

3. Paper feed switch - This switch sets the paper
feeding method to automatic feed mode or man-
ual feed mode.

4. Power socket - The power cable connects to the
power socket.

side the printer

1. Marking sticker - The marking sticker confirms
that the carriage is in the standard position. Try
not to smear the face of the sticker. If it gets dirty,
gently clean it with a dry cotton swab. As you do
so, be careful not to peel it off.

2. Ink cartridge holder plate - There are four holder
plates which hold the two ink cartridges each

3. Carriage - The
the specific ink
moves it to the
also contains th

4. Release lever -
the carriage an
jams. Press the
jammed paper.
the lever will au
position.

5. Print head - Th
Take care not to

1

2

3

5
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 switch set to position “A”Paper feed switch
tion “M”

nel

rea of the printer has two buttons and three
ator lights.  This area of the printer is called
l panel.

r button - Use the power button to turn the
er on and off.

y / Insert button - Use the ready / insert but-
o load and eject paper. When the paper feed
h is set in position “M”, this button is used
ed or eject paper.  The button is not func-
l when the paper feed switch is in position
 Pressing the ready / insert button for three
ds or more causes the printer to print a sam-

age. 

r light - This light blinks when a printer error
ccurred.

ownload.
Chapter 1 - Introduction

Caution:
Mishandling the print head or carriage can cause damage
to the printer. Also, never load an ink cartridge directly
into the carriage. Malfunction or damage to the printer
may result.

Paper feed switch

Caution:
Do not move the paper feed switch while paper is being
fed, otherwise the paper may feed in incorrectly. Move the
paper feed switch until it clicks into position “M” or “A”.
Paper will not feed properly unless the switch is correctly
set to either  “M” or “A”.

For continuous printing using automatic feeding, set the
paper feed switch to position “A”. To manually feed pa-
per, set the paper feed switch to position “M”.

Paper feed
set to posi

Control pa

The top a
LED indic
the contro

1. Powe
print

2. Read
ton t
switc
to fe
tiona
“A”. 
secon
ple p

3. Erro
has o
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10 User’s Guide

4. Ready light - This light illuminates when the
printer is ready to print. The light blinks slowly

In

p

re

e

Error Status
Light Status

Description
error

Blink

An electrical circuit error has
occurred.

Contents of printer memory
have been lost.

Blink

Printer is out of paper or de-
selected during paper feed

Paper jam detected.

Ink cart r idge  r ibbon needs
replacement.

Error detected during ink car-
tr idge change, or eight car-
tridges installed plus one on
carriage.

Printer mechanical error.

Front cover left open.

Necessary  ink cart idge not
installed or used up. Forced
printing still possible.

ownload.
while printing and goes out when printing has
paused or stopped.

5. Power light - Indicates whether the printer is on
or off. The light illuminates when the printer is
on. When the light is off, the internal functions of
the printer still retain power. To completely shut
off power to the printer, unplug the power cable
from the socket.

For a full description of the indicator lights refer to ‘In-
dicator Lights Summary’

dicator lights summary

Light Light status Printer status

ower

On Ready for operation

Fast blinking Printing sample page

Off Printer not ready

ady

On Select mode (ready to print)

Fast blinking Deselect mode (not ready)

Slow blinking Receiving or processing data

rror
Fast blinking Printer error detected

Off Normal

power ready

Ha r dwa re
error

Blink Blink
Nonvolatile
error

Out of paper

On Off

Paper jam

Ribbon end

C ar t r i d g e
change error

Mechanism
error

Front cover
open

N e c e s s a r y
r i b bo n  n o t
installed.
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odule, see ‘Connecting SCSI interface for
’ in Appendix A.

g the printer to a power supply

 the power cable into the power socket on the
ter. Make sure that the power cable is
ely seated in the socket.

1 3

ownload.
Chapter 2 - Initial Setup

Chapter 2 - Initial Setup

Connecting cables for Windows

When your printer has been positioned in a suitable lo-
cation, you can connect it to your Windows PC with a
printer cable and to a suitable AC power source with the
power cable.

Connecting the printer to your computer

Caution
Power to the printer and computer must be turned off and
the power cables unplugged before connecting or
disconnecting the printer cable. Otherwise damage or
malfunction may result.

Connect the printer to the computer with a bi-direction-
al printer cable. Secure the printer cable (1) to the con-
nectors on the printer (2) and on the computer (3).

Note
When using your printer with a Macintosh computer,
connect the printer to the Macintosh using a SCSI

interface m
Macintosh

Connectin

1. Plug
prin
secur

2
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2. Plug the free end of the power cable into a suita-
ble AC power source (such as a wall socket).

C
Po
ca
un
th

ownload.
aution:
wer to the printer is completely cut off only when the
ble is unplugged. Place the printer where you can easily
plug it from the wall socket. Also, pull the plug and not
e cable when unplugging the printer.
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Black 41067604

Plain paper

Laser paper

High grade paper

Yellow 41067603

Magenta 41067602

VPhoto primer

*1 41067606

Cyan 41067601

Finish II 41067607

Black 41067604

VPhoto print film

Yellow 41067603

Magenta 41067602

Cyan 41067601

Finish II 41067607

Gold foil 41067608 Plain paper

Laser paper

High grade paper

O ve r he a d
p ro j e c t o r
transparency film

Silver foil 41067609

White 41067610

Photo cyan 41067612

D ye  S ub  p a p er
(A4)

Photo magenta 41067613

Photo yellow 41067614

Photo overcoat 41067611

Ink cartridge 
type

Part number
Matching paper 

type

ownload.
Chapter 2 - Initial Setup

Ink cartridges

The following describes how to identify the different
types of ink cartridge and how to install and remove the
cartridges from the printer.

Identifying ink cartridge and paper types

The ink cartridge type is indicated on the surface of
each cartridge.

Printing type
Ink cartridge 

type
Part number

Matching paper 
type

Black text Econo Black 41067605

Plain paper

Laser paper

High grade paper

O ve r he a d
p ro j e c to r
transparency film

St a n da r d
colour printing
600 dpi

Black 41067604 Plain paper

Laser paper

High grade paper

Yellow 41067603

Magenta 41067602

Cyan 41067601

V P h o t o
printing (fine)
on plain paper
2400 dpi

V P h o t o
p r i n t i ng  o n
V P ho t o  f i lm
2400 dpi

S po t  c o l ou r
printing

D ye
sublimation

Printing type
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*1 Use VPhoto primer for any plain papers.

C
T
ca

C
P
co

C
P
ca
Se

In

1. The cartridge has a stopper (1) to prevent slack in
the ribbon (see below). Remove this stopper from

e.

rom the side marked “B” and turn
ly to take up any slack in the rib-

 cover by pushing the front cover
o release the internal lock. Gently
cover with your hand.

rtridge with your thumb and index
e side with the letter “B” and the
logo faces upward.

nd of the ink cartridge into the ink
r, while pushing the left side latch
lightly to the left along with the

W

IND

ownload.
aution 1
he manufacturer only recommends printing with the
rtridge-paper combinations listed in Table 1.

aution 2
rinting with an inappropriate ink cartridge-paper
mbination can damage the cartridge ribbon.

aution 3
rinting outside the printable paper area can damage the
rtridge ribbon. Always print within the printable area.
e ‘Printable Area’ in Specifications and Settings.

stalling ink cartridges

Install ink cartridges by following the steps below.

the ink cartridg

2. Insert a pencil f
the pencil slow
bon (1).

3. Open the front
release button t
lower the front 

4. Hold the ink ca
finger so that th
manufacturer’s 

5. Insert the left e
cartridge holde
of the holder s
cartridge.

1
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 the second ink cartridge on top of the ink
idge already installed.  Gently push down the
e of the ink cartridges.

 marked “B” face up. If the ink cartridge is
de down, the printer will not know it has
d. Only the Econo Black and Finish
e reversible.

ownload.
Chapter 2 - Initial Setup

Note
The printer carriage located inside the printer can
select and pick up the necessary ink cartridge from any
holder. You can place up to 7 cartridges of the same
colour in the holders to reduce the need to change ink
cartridges.

Caution
The ink cartridges may be put in any holder but DO NOT
put ink cartridges directly into the carriage. Doing so may
result in damage to the printer.

6. Push down the right side of the ink cartridge.
Make sure that the ink cartridge is securely
locked into the holder, and that there is no slack
in the ribbon.

7. Place
cartr
centr

Caution 1:
Place the side
installed upsi
been installe
Cartridges ar
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Caution 2:
Yo
pr
ca

R

2. Removing an ink cartridge is similar to installing
it. Hold the centre of the cartridge with your

x finger. Push the left latch on the
older slightly to the left with the

ht side of the cartridge, and then
re ink  cartridge. Insert a new ink
lowing the steps described earlier.

ownload.
u must leave at least one cartridge holder empty for the
inter to operate properly. Do not install more than 7 ink
rtridges.

eplacing or changing ink cartridges

When you want to change ink cartridges or replace a
cartridge whose ribbon has been used up, remove the
cartridges by the following steps.

Note 1:
When an ink cartridge has been used up, black and sil-
ver stripes will be visible on the ribbon.

Note 2:
To reverse a Finish II or Econo Black ink cartridge, flip
the cartridge over and manually advance the ribbon
until the black and silver stripes (1) disappear.

1. Open the front cover by pushing the front cover
release button.

thumb and inde
ink cartridge h
cartridge.

3. Lift up the rig
remove the enti
cartridge by fol

1
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 on the following; thermal paper, paper
r use in ink jet printers, glossy paper (paper
 has been specially treated), and envelopes.
 damage the printer.

oo many sheets into the sheet feeder may
er jams or misfeeding.

that when using automatic feed mode, the
will occasionally feed incorrectly depending
er type.

 precautions about paper

r’s sheet feeder can feed paper to the printer
lly, which is the most convenient method of
he sheet feeder holds up to 100 sheets of

r (or 30 transparencies) at once.

ownload.
Chapter 2 - Initial Setup

Loading paper

The following paragraphs explain how to load paper
into the printer.

Paper types and available feeding modes

The table below shows information on switching be-
tween automatic and manual feeds, and on setting the
paper feed switch (“A” or “M”).

*1 For VPhoto Print Film, use single sheet and
manual feed.

*2 To continuously print Dye Sub Paper, always
use the guide sheet (included in the supplies).

Caution:
Do not print
exclusively fo
whose surface
Doing so may

Note 1:
Loading t
cause pap

Note 2:
Be aware 
last sheet 
on the pap

Notes and

The printe
automatica
printing. T
plain pape

Media type
Automatic feed 

mode
Manual feed 

mode

Plain paper (for plain paper
copiers)

A M

Laser paper / High Grade Paper A M

VPhoto Print Film (A4) A*1 M

O ve rh e a d  P r o je c t o r
Transparency Film

A M

Other media (thick paper, etc.) x M

Dye Sub Paper (A4) A*2 M
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Thick paper and other kinds of special printing media
should be used in manual feed mode. The approximate

C
N
th
au
pa
m
da

• When printing on Dye Sublimation Paper, use
only Dye Sublimation ink cartridges. Be sure to

inting to the glossy printable area
t outside this area, you may dam-

ridge.

on a thick sheet, or an irregular
heet allow a 1/2 inch (12 mm)
eft and right side to prevent print-
per edge, this could result in tear-
idge ribbon.

on used sheets (already printed on
 use manual feed only. Automatic
feed used sheets properly. When
ed, avoid repeatedly inserting and
me sheet.

 automatic feed mode

 mode for continuous printing.
ds for loading paper, depending on

A

M

ownload.
thicknesses of paper that can be used in manual feed
mode or automatic feed mode are as follows:

aution:
ever use paper in the sheet feeder with thickness outside
e range 0.07 mm - 0.10 mm (0.003" - 0.004") in
tomatic feed mode.  In manual feed mode, never use
per whose thickness is outside the range 0.07 mm - 0.23

m (0.003" - 0.01").  Doing so may cause paper jams or
mage to the printer.

Paper jams can be caused by feeding in paper that is ex-
tremely smooth or shiny, too rough, or paper that easily
picks up static electricity. Paper jams and other paper
feed problems can tear the ribbons in ink cartridges.

To avoid such problems, please note the following pre-
cautions:

• Always use the recommended paper types, and
be sure to set the printer’s paper options properly.
Settings that are not appropriate for the paper
being used can cause paper jams.

confine your pr
only. If you prin
age the ink cart

• When printing 
postcard-size s
margin on the l
ing over the pa
ing the ink cartr

• When printing 
the same side),
feed may not 
using manual fe
removing the sa

Loading paper in

Use automatic feed
There are two metho
the media.

Feed Mode Min. Max.

utomatic 0.07mm (0.003") 0.10mm (0.004")

anual 0.07mm (0.003") 0.23mm (0.01")
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he paper feed guide to the paper size.

 creased or curled paper, this can cause the
isfeed.

per once before placing it in the sheet feeder.
revent the paper sticking and printer feeding
of sheets together.

ownload.
Chapter 2 - Initial Setup

Loading high grade/plain/laser paper and 
transparencies

1. Pull the paper support upwards.

2. Select the paper feed mode by switching the
paper feed switch to position “A”.

3. Place the paper in the sheet feeder.

4. Adjust t

Note 1:
Do not use
paper to m

Note 2:
Fan the pa
This will p
a number 
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Note 3:

L
the paper stopper is not lifted.

aper straight into the sheet feeder.

ownload.
Use only one type of paper at a time.

Note 4:
Pushing the paper feed guide too hard against the
paper can bend the paper. Adjust the position of the
paper feed guide so that it just touches the paper.

oading paper in manual feed mode

Use manual feed mode when printing on thick paper,
cards and other kinds of special printing media. In man-
ual feed mode you should load only one sheet at a time.

1. Switch the paper feed switch to position “M”.

2. Remove any paper from the sheet feeder.

3. Make sure that 

4. Insert the sheet of p
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ownload.
Chapter 2 - Initial Setup

Note 1:
Paper that is creased or curled may print incorrectly.

Note 2:
Make sure that you insert the paper straight. Inserting
it at a slant can cause a paper jam.

5. Adjust the paper feed guide to the paper size.

6. Press the ready/ insert button. The paper is auto-
matically pulled into the printer.

ready / insert
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ownload.
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, Windows

n the power

 printer and computer on or off in the follow-

 the power button on the printer to turn it on.

 on your computer.

quirements

 requirements for the supplied printer driver
ws:

 required during printing is as follows:

M PC-AT or compatible

icrosoft Windows 95/98

 MB or more (32 MB or more is recommended)

Monochrome image Colour image

rinting 20MB 80MB

ownload.
Chapter 3 - Installation and Operation, Windows

Chapter 3 - Installation and Operation

Installing the printer driver

Before you can use your printer, you need to install the
correct printer driver software into your computer so
that it can operate with the printer. The following para-
graphs describe how to install the printer driver.

Purpose of the printer driver

The printer driver software helps to control the printing
process, so the driver you select must match the printer
you are using. When printing from an application in
Windows, always use the printer driver specifically de-
signed for your printer model.

To take full advantage of the many features of your
printer, always create your documents after you have
selected the correct printer driver. If you have a differ-
ent printer driver selected when you print a document,
then only the print settings that match functions of your
printer will be valid.

Turning o

Turn your
ing order;

• Push

• Turn

System re

The system
are as follo

Disk space

Computer: IB

Windows: M

Total RAM: 16

VPhoto Colour P

Download from Www.Somanuals.com. All Manuals Search And D



24 User’s Guide

Note 1:

In

Installing printer software using Plug & 

ing the printer driver software us-
he Add Printer Wizard, Windows
e the printer driver to install. When
 installation disc into your CD-

 OK. Follow the instructions on the
e installation.

p

vides DMA/ECP and ECP parallel
ow you to print at higher speed.
t meet the following system re-
 high speed printing function.

tomatically set the I/O Port Speed
puter has the ECP capable paral-
r computer's reference manual for

pable parallel port and DMA supported

arallel port

patible computer

ownload.
The figures in Table 2 are approximations of the total
disc space required when printing at VPhoto Colour
mode.

Note 2:
The working disk space needed during printing is auto-
matically erased after printing is completed.

stalling printer software from CD

The printer driver is included on the supplied installa-
tion disc. To install the printer driver software for Win-
dows 95/98® follow these steps.

1. Insert the OKI DP-5000 installation disk into
your CD-ROM drive. If a window does not
appear automatically, double-click the OKI
installation disc to open it, and then double-click
the ‘setup.exe’ file.

2. In the window that appears, choose Install Driver.

3. Choose the language of the printer driver that you
wish to install.

4. Follow the instructions on-screen to complete the
installation

Play

When you are install
ing Plug & Play or t
will ask you to choos
prompted, insert the
ROM drive and click
screen to complete th

Port monitor setu

The Port Monitor pro
port settings that all
Your computer mus
quirements to use the

Note:
The Installer will au
to Faster, if your com
lel port. Refer to you
details.

DMA Access ECP ca

Faster ECP capable p

Standard Any IBM com
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 error

 Port Speed Error’ message appears, you
e parallel port configuration to ECP mode in

settings for the parallel port to use the DMA.
our computer's reference manual for details.

LPT port

mputer has additional parallel ports, you can
sources dialogue box to select the IRQ and
nel.

ure that there is no conflict in the address as-
. The PC can support up to three parallel ports
there are no conflicts for each port.

ownload.
Chapter 3 - Installation and Operation, Windows

Select the I/O port speed

1. Choose Settings from the Start menu, and then
select Printers. In the Printers window that
appears, right-click the DP-5000 printer icon.
Then select Properties.

2. Click the Details tab, and then click the Port Set-
tings… button.

3. In the Configure LPT Port window that appears,
select an option. Then click OK.

Note 1:
To use DMA access your computer must be able to sup-
port this, and you must ensure that your parallel port is
set to use DMA in the computer’s BIOS settings. Refer
to your computer's reference manual for details.

Note 2:
To use the “Faster” option your computer must be able
and set to support ECP mode in the BIOS settings.
Refer to your computer's reference manual for details.

4. Click OK to close the Properties window

Port speed

If the ‘I/O
must set th
the BIOS 
Refer to y

Configure 

If your co
use the Re
DMA Chan

Please ens
signments
as long as 
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Printing operations

P

R

will help make many plain papers
g. See Chapter 5, ‘Specialized
 for details.

r monochrome printing

data consisting of text and/or
reated by an application. 

ridge in your printer

ne black or Econo Black ink car-
he ink cartridge holders.

rtridge directly into the carriage.
e printer.

ink cartridges in the four ink car-
be used in the selected printing
ill automatically pick up that ink

ownload.
When you have connected the cables to your printer and
have installed the printer driver, you are ready to use
your printer. This section describes step by step opera-
tions for monochrome and colour printing.

rinting in monochrome

The following paragraphs explain how to perform mon-
ochrome printing on plain paper.

equirements

You need the following items for monochrome print-
ing;

1. Ink cartridge

a Black ink cartridge or Econo Black ink car-
tridge.

2. Media

a High Grade Paper

b Laser paper or plain paper

c VPhoto Print Film.

Note:
Our VPhoto Primer 
suitable for printin
Printing Operations’

3. Printing data fo

a Printing 
graphics c

Placing an ink cart

Make sure at least o
tridge is installed in t

Caution:
Do not place an ink ca
Doing so may damage th

Note 1:
If at least one of the 
tridge holders can 
mode, the carriage w
cartridge.
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t a paper type from the Media Type menu.

t either Standard Colour or Economy
k from the Print Mode menu.

If you have installed a black ink cartridge,
select Standard Colour.

If you have installed an Econo Black ink
cartridge, select Economy Black.

 the More Settings button on Document
ity tab. If you selected Standard Colour for
rint Mode, you can now select either Fine or
dard in the Print Quality menu.

black in Fine, select Grayscale or Mono-
xt from the Document Type menu and Plain
aser Paper from the Media Type menu in the
/Quality tab. Then set to Fine in the More
ialogue box.

the Eject Paper Quicker in the Printing
ting shortens the printing time. This option is
ble when you have selected to print in either

me or Greyscale.

e Properties window of the Print dialogue
elect Paper tab.

ownload.
Chapter 3 - Installation and Operation, Windows

Note 2:
Refer to Installing Ink Cartridges’ in Chapter 2 for
directions on installing ink cartridges.

Note 3:
Installing multiple ink cartridges of the same colour
allows you to print more pages without stopping to
replace spent ink cartridges.

Note 4:
Econo Black cartridges can be reversed up to 20 times.

Load the paper into your printer.

Setting up the printer driver for monochrome 
printing

1. In the application you want to print from, select
Print from the File menu to open the Print dia-
logue box.

Note:
Please note that the procedure for opening the dia-
logue box of the driver may differ slightly from one
application to another.

2. In the Print dialogue box click Properties.

3. In the Document Quality tab click either Greys-
cale or Monochrome Text from the Document
Type menu.

4. Selec

5. Selec
Blac

a

b

6. Click
Qual
the P
Stan

Note 1:
To print 
chrome Te
Paper or L
Document
Settings d

Note 2:
Checking 
Option set
only availa
Monochro

7. In th
box s
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8. Set the Paper Size, Orientation, and number of
as required.

P

R

b Laser paper or plain paper

int Film

r colour printing

data consisting of text and/or
reated by an application.

rimer will help make many plain
ll-colour printing. See Chapter 5,
 Operations’ for details.

es in your printer

rtridges listed above are installed.
ay be installed in any order.

rtridge directly into the carriage.
e printer.

our printer.

ownload.
Copies 

9. When you have completed all the setup, click OK
to close the printer driver Properties dialogue
box.

10. Click OK in the Print dialogue box to start print-
ing.

rinting in colour

The following paragraphs describe how to print stand-
ard colour images on plain paper.

equirements

You need the following items for standard colour print-
ing;

1. Ink cartridges

a Black ink cartridge

b Cyan ink cartridge

c Magenta ink cartridge

d Yellow ink cartridge

2. Media

a High grade paper

c VPhoto Pr

3. Printing data fo

a Printing 
graphics c

Note:
Using our VPhoto P
papers suitable for fu
‘Specialized Printing

Placing ink cartridg

Make sure the ink ca
The ink cartridges m

Caution:
Do not place an ink ca
Doing so may damage th

Load the paper into y
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n you have completed all the setup, click OK
ose the printer driver Properties dialogue

 OK in the Print dialogue box to start print-

n reverse side

00 printer has a special option for printing on
e side of paper. The Print On Reverse Side
ps the paper curl reforming process for best
sults.

 the printer driver for printing on 
e

e application you want to print from, select
t from the File menu to open the Print dia-
 box.

e Print dialogue box click Properties.

e application you want to print with, select
t from the File menu to open the Print dia-
 box.

 Properties. The printer Properties dialogue
ppears.

ownload.
Chapter 3 - Installation and Operation, Windows

Setting up the printer driver for colour 
printing

1. In the application you want to print from, select
Print from the File menu to open the Print dia-
logue box.

Note:
Please note that the procedure for opening the dia-
logue box of the DP-5000 driver may differ slightly
from one application to another.

2. In the Print dialogue box click Properties.

3. Select Automatic, Photographs or Graphics/
Text from the Document type menu on the Doc-
ument/Quality tab. When you select Automatic
in the Document Type, the black printing data
will be printed in black, and the colour printing
data will be printed in full colour.

4. Select a paper type from the Media Type menu.

5. Select Standard Colour, Glossy Finish or
VPhoto Colour from the Print Mode menu.

6. Click the More Settings button on Document
Quality tab. Select the desired quality from the
Print Quality menu.

7. Whe
to cl
box.

8. Click
ing.

Printing o

The DP-50
the revers
option ski
printing re

Setting up
reverse sid

1. In th
Prin
logue

2. In th

3. In th
Prin
logue

4. Click
box a
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5. In the Document/Quality tab click Print On
 option.

C
W
ne
th
en

Turning off the power

rinting, turn off your printing de-
g order;

 and then turn off your computer.

 button on the printer to turn it off.

ownload.
Reverse Side

Note:
Note that when you select certain media types the Print
on Reverse Side option will not be available.

6. Select Automatic, Photographs, or Graphics/
Text from the Document Type menu. When you
select Automatic here, the black & white printing
data will be printed in black & white, and the col-
our printing data will be printed in full colour.

7. Select a paper type from the Media Type menu.

8. Select Standard Colour, Glossy Finish, or
VPhoto Colour from the Print Mode menu.

9. When you complete the setup, click OK to close
the printer driver Properties dialogue box.

10. Click OK in the Print dialogue box to start print-
ing.

aution:
hen printing on the reverse side of paper, the printer
eds periodic maintenance for cleaning. See ‘Cleaning
e Feed Roller’ and ‘Cleaning the Platen’ in Chapter 6 to
sure best results when printing.

When you finished p
vices in the followin

• Quit Windows,

• Push the power
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, Macintosh

 for installation

stalling the printer driver, check your hard
the Disk First Aid utility to make sure that it
ious problems. Refer to the Macintosh User
information about using Disk First Aid.

e power

 printer and computer on or off in the follow-

e power button on the printer to turn it on.

 your computer.

quirements

m and disk space requirements for the DP-
er driver are as follows:

ownload.
Chapter 4 - Installation and Operation, Macintosh

Chapter 4 - Installation and Operation

Installing the printer driver

Before you can use your printer, you need to install the
correct printer driver software so that your computer
can work with the printer.

This chapter describes how to install the supplied print-
er driver for an Apple Macintosh. These directions as-
sume that you are familiar with normal Macintosh
operations, such as using the mouse and menus. Please
refer to the User’s Guide that came with your Macin-
tosh if you need information about general Macintosh
operations.

Purpose of the printer driver

The printer driver is software that enables your compu-
ter to control the printer. When printing from any appli-
cation, you must select a printer driver that matches the
printer being used in order to ensure accurate printing
results. To take advantage of the many features of this
printer, select the correct printer driver before creating
your documents.

Preparing

Before in
disk with 
has no ser
Guide for 

Turn on th

Turn your
ing order;

• Push th

• Turn on

System re

The syste
5000 print
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C

Installing the printer driver software

es the printer driver software. To
er software onto your Macintosh,

 DP-5000 installation disk into
drive.

ish’ folder, and then double-click
KI DP-5000 icon.

uctions on-screen to complete the

lp

on all versions of MacOS from 7.1
ing Balloon Help, you can get a
f each function. Follow the steps
 Help.

Balloons from the Help menu
enu bar, at the upper right corner

or over the button or box to be

 Help, select Hide Balloons from

C

O

T

V

ownload.
Note 1:
The figures in Table 2 are approximations of the total
disk space required when printing at VPhoto Colour
mode.

Note 2:
The working disk space needed during printing is auto-
matically erased after printing is completed.

ontents of the installation disk

The files shown below are contained on the supplied
CD-ROM installation disc. The installer will install the
following files:

• Printer Driver

• Queue Monitor (background printing application)

• Queue Watcher (background printing extension)

• ColorSync

The CD-ROM includ
install the printer driv
follow these steps:

1. Insert the OKI
your CD-ROM 

2. Open the ‘Engl
on the Install O

3. Follow the instr
installation.

Using balloon he

Balloon Help works 
upwards. By display
simple explanation o
below to use Balloon

1. Select Show 
(found on the m
of the screen).

2. Move the curs
explained.

3. To hide Balloon
the Help menu.

omputer: Apple Macintosh computer or compatible

perating system: System 7.1 or later

otal RAM: 16 MB or more (32 MB or more is recommended)

Monochrome image Colour image

Photo Printing 20MB 80MB
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u have several identical printers connected,
 on the SCSI device number of the printer
ill use. The factory device setting is #6. To

ge SCSI device numbers, see  ‘Specifications
ettings’ in Chapter 8.

e more than one SCSI bus in your Macintosh,
BUS #1” or similar will be displayed.

ly following installation, background print-
ned off. Click on the On button to enable
d printing. Background printing will not be
if you did not install the Queue Kit software.

 on the Close box to close the Chooser.

n the selected printer driver is changed from
vious printer driver, a dialogue box will
ar to inform you that a different printer has
 selected. Click on the OK button to close the
gue box.

e printer

ure the printer is functioning correctly, use
esktop command in the Finder. Before us-
esktop check the following:

ownload.
Chapter 4 - Installation and Operation, Macintosh

Selecting the correct driver

Before creating any documents in your application you
should select the DP-5000 printer driver which you in-
stalled from the CD-ROM. If you want to print docu-
ments created when this printer driver was not selected,
first select the DP-5000 printer in the Chooser menu,
then choose Page Setup from your application’s File
menu. Finally change the application’s page format and
other settings if needed.

Follow the steps below to select the correct printer driv-
er.

1. From the Apple menu, select the Chooser.

2. Click on the DP-5000 printer driver icon on the
left side of the screen. The box on the right dis-
plays the SCSI device number of the printer.

Note:
Make sure the device number in the Select a SCSI port
box is highlighted. If it is not, your printer is not being
recognised. Click on the device number a few times. If
it is still not highlighted, it is possible that the Finder
has insufficient memory. In this case, close the
Chooser, run any one of your application programs,
and select the printer from the Chooser again.

3. If yo
click
you w
chan
and S

Note 1:
If you hav
“SCSI #6 

Note 2:
Immediate
ing is tur
backgroun
available 

4. Click

5. Whe
a pre
appe
been
dialo

Testing th

To make s
the Print D
ing Print D
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1. The printer is connected to the computer and is
turned on.

P

P

Print preview

r printed job by clicking the Pre-
int dialogue box, the desktop will
o print the desktop, click Print
s.

rinting, turn off your printing de-
g order;

, if needed) turn off your compu-

 button on the printer to turn it off.

ownload.
2. The system folder window is open (if not, double-
click the folder on the startup disk).

3. There is paper in the printer.

age setup dialogue box

1. Select Page Setup from the File menu. The Page
Setup dialogue box opens.

2. Make sure the paper type and size settings match
the paper loaded in the printer, (factory settings
are Laser Paper, A4). If the paper type does not
match, select the appropriate settings.

3. Close the Page Setup box by clicking OK.

rint dialogue box

1. Select Print Desktop from the File menu. The
Print dialog box opens.

2. Select required settings and click Print to begin
printing.

You can preview you
view button in the Pr
appear on screen. T
Page. Printing begin

When you finished p
vices in the followin

1. Shut down (and
ter.

2. Push the power
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to Primer will help make many plain papers
or printing. See Chapter 5, ‘Specialized
perations’ for details.

ing data

Printing data consisting of text and/or
graphics created in your application. 

 ink cartridge in your printer

 at least one black or Econo Black ink car-
stalled in the ink cartridge holders.

 an ink cartridge directly into the carriage.
 damage the printer.

one of the ink cartridges in the four ink car-
ders can be used in the selected printing
carriage will automatically pick up that ink

ownload.
Chapter 4 - Installation and Operation, Macintosh

Printing operations

When you have connected the cables to your printer and
have installed the printer driver, you are ready to use
your printer. The following describes step by step oper-
ations for monochrome and colour printing.

Printing in monochrome

The following paragraphs explain how to perform mon-
ochrome printing on plain paper.

Requirements

You need the following items for monochrome print-
ing:

1. Ink cartridge

a Black ink cartridge or Econo Black ink car-
tridge.

2. Media

a High Grade Paper

b Laser paper or plain paper

c VPhoto Print Film.

Note:
Our VPho
suitable f
Printing O

3. Print

a

Placing an

Make sure
tridge is in

Caution:
Do not place
Doing so may

Note 1:
If at least 
tridge hol
mode, the 
cartridge.
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Note 2:

S
p

5. Select Print from the File menu.

sary changes to the settings in the
ox.

er Greyscale or Black & White
ype menu.

u install a black ink cartridge,
ndard Colour from the Mode

 install an Econo Black ink car-
lect Economy Black from the
u.

ng your changes, click Print to

raphs describe how to print stand-
 plain paper.

ng items for standard colour print-

cartridge

ownload.
Refer to ‘Installing Ink Cartridges in Chapter 2 for
directions on installing ink cartridges.

Note 3:
Installing multiple ink cartridges of the same colour
allows you to print more pages without stopping to
replace spent ink cartridges.

Note 4:
Econo Black cartridges can be reversed up to 20 times.

Load the paper into your printer, for reference see
Chapter 2, ‘Loading Paper.

etting up the printer driver for monocrome 
rinting

1. In the application you want to print from, select
Page Setup from the File menu to open the Page
Setup dialogue box.

2. Make any necessary changes to the settings in the
Page Setup dialogue box.

3. Set the Media to Plain Paper or Laser Paper and
the Size to A4. When using a different type or
size of paper, change the setup accordingly.

4. Click OK to close the Page Setup dialogue box.

6. Make any neces
Print dialogue b

a Select eith
from the T

b When yo
select Sta
menu.

c When you
tridge, se
Mode men

7. After completi
start printing.

Printing in colour

The following parag
ard colour images on

Requirements

You need the followi
ing:

1. Ink cartridges

a Black ink 
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paper into your printer, for reference see
 ‘Loading Paper.

 the printer driver for colour 

w steps 1 to 4 in ‘Setting up the printer
r for monochrome printing’.

e Print dialogue box select either Automatic,
ographs, or Graphics & Text from the Type
.

 select Photographs from the Type menu,
ck is automatically selected in the Colour
ection of the Image Settings dialogue.

 menu is set to Greyscale or Black & White
ed image will be printed in monochrome or
le.

 the Image button in the Print dialogue box.

e colour matching selections as required. For
tion information see “Setting up colour

hing option”.

 the settings have been completed, click OK.

ownload.
Chapter 4 - Installation and Operation, Macintosh

b Cyan ink cartridge

c Magenta ink cartridge

d Yellow ink cartridge

2. Media

a High grade paper

b Laser paper or plain paper

c VPhoto Print Film

3. Printing data

a Printing data consisting of text and/or
graphics created in your application.

Note:
Using our VPhoto Primer will help make many plain
papers suitable for full-colour printing. See Chapter 5,
‘Specialized Printing Operations’ for details.

Placing ink cartridges in your printer

Make sure the ink cartridges listed above installed. The
ink cartridges may be installed in any order.

Caution:
Do not place an ink cartridge directly into the carriage.
Doing so may damage the printer.

Load the 
Chapter 2,

Setting up
printing

1. Follo
drive

2. In th
Phot
menu

Note 1:
When you
Darker Bla
Matching s

Note 2:
If the Type
the colour
in greysca

3. Click

4. Mak
selec
matc

5. After
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6. When you have completed your settings, click
in the Print dialogue box. The printer prints

S

on a monitor because the printer uses inks to create
onitor uses light. However, the

tch the monitor colours as closely

ching - The colour information for
put directly to the printer.

llow these steps.

rSync™ System Profile in the
anels and click Set Profile... 

 Monitor-D50 from the list dis-
n click Select.

e indicates the colour temperature
 monitors are set to a colour tem-
0K). However, CIE sets a colour

(5000K) as a reference for colour
n the human colour sense under a
. The ColorSync™ profile of this

his standard.

r’s Colour Temperature. Since the
file is set to DP-5000 Monitor-
er and monitor colours will not
e colour temperature of your mon-
0. To set the monitor’s colour tem-

ownload.
Print 
cyan, magenta, yellow, and black in that order as
the print head moves back and forth over the
paper.

Note 1:
If the four ink cartridges (cyan, magenta, yellow, and
black) are not installed, the error light will flash, and
the printer will not print.

Note 2:
See Chapter 2, ‘Initial Setup’, for information on
installing ink cartridges.

etting up colour matching option

The printer has the following colour-matching options:

1. OKI DP-5000 Driver mode - This mode provides
unique OKI colour matching. It is the default
mode for colour printing.

2. ColorSync mode - When ColorSync is selected,
the printer performs colour management using
ColorSync™, which is part of the Macintosh sys-
tem software.

Note:
A printer cannot exactly reproduce the colours shown

colours while the m
printer will try to ma
as possible.

3. No Colour Mat
print data is out

To use ColorSync, fo

1. Open the Colo
Apple Control P

2. Select DP-5000
played, and the

Note:
The D50 in the profil
of the monitor. Most
perature of D93 (930
temperature of D50 
reproduction based o
standard light source
printer conforms to t

3. Set the Monito
ColorSync pro
D50, the print
match unless th
itor is set at D5
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rSync from the Colour Matching options.
 the settings have been completed, click OK.

ting a photograph, it is advisable to turn on
 Black option. The darkness graduation will
oothed because black will be expressed by

lours .

 returning to the Print dialogue box, click
 to start printing.

n reverse side

00 printer has a special option for printing on
e side of paper. The Print On Reverse Side
ps the paper curl reforming process for best
sults.

 the printer driver for printing on 
e

e application you want to print with, select
 Setup from the File menu to open the Page
 dialogue box.

e any necessary changes to the settings in the
 Setup dialogue box.

ownload.
Chapter 4 - Installation and Operation, Macintosh

perature see your computer’s reference manual
for details.

Note 1:
Some monitors do not allow the colour temperature to
be changed. In this case, open Monitor & Sound in
Control Panels and set the Gamma option to Page-
White Gamma, which provides a colour temperature
similar to D50.

Note 2:
Once you have completed steps 1 through 3, you
should not need to repeat them unless you wish to
change the settings.

4. Prepare print data and set up the paper for print-
ing. Select Print from the File menu.

Note:
The contents of the Print dialogue box depend on the
application software. If the colour setting options
RGB, CMYK, or others are available in the dialogue
box, select the RGB option. If you select the CMY
option, the printed output will differ from the colours
displayed on the monitor.

5. To enable the ColorSync function during printing.
Click the Image.. button in the Print dialogue box
to display the Colours dialogue box. Select

Colo
After

Note:
When prin
the Darker
then be sm
all four co

6. After
Print

Printing o

The DP-50
the revers
option ski
printing re

Setting up
reverse sid

1. In th
Page
Setup

2. Mak
Page
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3. Set the Media to Plain Paper or Laser Paper,
and the  to . When using a different type

Caution:
everse side of paper, the printer
ance for cleaning to ensure best
e Feed Roller’ and ‘Cleaning the

tain media types this option will

 Print dialogue box to start print-

ownload.
Size A4
or size of paper, change the setup accordingly.

4. After making any changes required, click OK to
close the Page Setup dialogue box.

5. Select Print from the File menu to display the
Print dialogue box.

6. Select either Automatic, Photographs or Graph-
ics & Text from the Type: menu.

Note 1:
When you select Photographs from the Type menu,
Darker Black is automatically selected in the Colour
Matching section of the Image... settings dialogue.

Note 2:
If the Type menu is set to Greyscale or Black & White
the coloured image will be printed in monochrome or
in greyscale.

7. Click Image... in the Print dialogue box.

8. Make colour matching selections as required.
After the settings have been completed, click OK.

9. In the Print dialogue box select Print On Reverse
Side option.

When printing on the r
needs periodic mainten
results. See ‘Cleaning th
Platen’ in Chapter 5 

Note:
When you select cer
not be available.

10. Click OK in the
ing.
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ations

Black ink cartridge

Finish II ink cartridge

e image to be printed

 image or document you want to print by ar-
xt, graphic objects, photographs, etc. in your
.

artridges

 five ink cartridges listed above into the ink
olders. The ink cartridges may be installed in
  For details on installation refer to ‘Installing
ges’ in Chapter 2. 

to print film in your printer

se either automatic feed mode (position ‘M’)
 feed mode (position ‘A’) when loading the
our printer.

ownload.
Chapter 5 - Specialised Printing Operations

Chapter 5 - Specialised Printing Oper

VPhoto colour printing

Colour printing on VPhoto print film

The following describes how to print colour images on
VPhoto print film. Photographic-like quality can be
achieved by printing images on VPhoto print film with
standard inks. This is very effective when printing mul-
ticolored images such as  computer graphics.

Requirements

You need the following items for colour printing on
VPhoto print film.

1.  Media

a VPhoto Print Film (A4)

2.  Ink Cartridges

a Cyan ink cartridge

b Magenta ink cartridge

c Yellow ink cartridge

d

e

Prepare th

Create the
ranging te
application

Install ink c

Install the
cartridge h
any order.
Ink Cartrid

Load VPho

You may u
or manual
film into y
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Note:

S

want this setting, click the More Settings button, then
Glossy Finish check box.

 Print dialog box to start printing.

n plain paper

bes how to print colour images on
 VPhoto print film, photogravure-
hieved by printing colour images

ing items for colour printing on

e Paper or Plain Paper (A4)

artridge

nk cartridge

 cartridge

cartridge

k cartridge

ownload.
VPhoto Print Film is very adhesive. When loading the
multiple sheets, fan them thoroughly before loading to
make sure that they do not adhere to one another. Store
unused sheets in the package. For best results, use sin-
gle sheet and manual feed.

et up the printer driver for printing

1. Select Print from the File menu to open the Print
dialog box, then click Properties.

2. Click the Document/Quality tab to bring to the
front.

3. Select Automatic, Photographs or Graphics/
Text from the Document Type depending on the
document to be printed.

4. Select VPhoto Print Film from the Media Type
setting.

5. Make any other necessary changes to the settings.

6. When you complete the setup, click OK to close
the dialog box.

Note:
When VPhoto Print Film is selected from the Media
Type, Glossy Finish is automatically set. We recom-
mend that Glossy Finish is normally set. If you do not

uncheck the 

7. Click OK in the

Colour printing o

The following descri
plain paper. As with
like quality can be ac
on plain paper.

Requirement

You need the follow
plain paper.

1.  Media

a High Grad

2. Ink Cartridges

a Cyan ink c

b Magenta i

c Yellow ink

d Black ink 

e Finish II in

Download from Www.Somanuals.com. All Manuals Search And D



English

43

 printer driver for printing

t Print from the File menu to open the Print
g box, then click Properties.

 the Document/Quality tab to bring to the
.

t Automatic, Photographs, or Graphics/
from the Document Type depending on the
ment to be printed.

t Plain Paper or Laser Paper for high grade
r from the Media Type setting.

rint Mode to VPhoto Colour.

er Paper and VPhoto Colour are selected
Media Type and Print Mode, respectively,
ish is automatically set. We recommend that
ish is normally set. If you do not want this

ick the More Settings button, then uncheck
 Finish check box.

n Paper and VPhoto Colour are selected from
 Type and Print Mode, respectively, VPhoto
n-dercoat) and Glossy Finish are automati-
Photo Primer (Undercoat) is set when Auto-

ownload.
Chapter 5 - Specialised Printing Operations

f VPhoto Primer ink cartridge

Note:
To print the photo quality images on plain paper, use
VPhoto Primer ink. VPhoto Primer ink fills any une-
venness on the paper surface, so that a similar print
quality as on VPhoto Print Film can be achieved. 

Prepare the image to be printed

Create the image or document you want to print by ar-
ranging text, graphic objects, photographs, etc. in your
application.

Install ink cartridges

Install the ink cartridges listed above into the ink car-
tridge holders. The ink cartridges may be installed in
any order. For details on installation refer to ‘Installing
Ink Cartridges’ in Chapter 2. 

Load the paper in your printer

You may use either automatic feed mode (position ‘M’)
or manual feed mode (position ‘A’) when loading the
film into your printer.

Set up the

1. Selec
dialo

2. Click
front

3. Selec
Text 
docu

4. Selec
pape

5. Set P

Note 1:
When Las
from the 
Glossy Fin
Glossy Fin
setting, cl
the Glossy

Note 2:
When Plai
the Media
Primer (U
cally set. V
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matic, Photographs, or Graphics/Text is selected from
Document Type

ownload.
. 

6. Make any other necessary changes to the settings.

7. When you complete the setup, click OK to close
the dialog box.

8. Click OK in the Print dialog box to start printing.
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le foil colour printing (without halftone) -
colour printing using a single colour (gold or
r).

i foil colour printing - Foil colour printing
 two colours (gold and silver).

colour plus foil colour printing - Simultane-
ull colour and foil colour printing.

l colour printing

l colour printing uses just one foil colour.
oil colour to be used is installed in the printer.
od of printing is used when an entire image
 grayscale images) or document is going to
 in a single foil colour. Single foil colour
n be used even when the application you are
 not allow designation of colour components.

ownload.
Chapter 5 - Specialised Printing Operations

Printing in foil colour

Foil colour printing is one of the unique features of the
OKI DP-5000 printer. The printer driver allows you to
select specific colours or colour components that will
be replaced by foil colours and black ink when printing.

You can print with up to two foil colours, (or two foil
colours plus black) from most applications that allow
colour specification. Moreover, because foil inks are
opaque, foil colour printing is unaffected by the colour
of the underlying paper. As a result, you can print on
coloured plain paper.

Note 1:
Special colour ink is used for foil colour printing.
Therefore, undercoat must be applied using cyan,
magenta, yellow, and black inks before printing Foil
Colour.

Note 2:
Depending on the font type, size or paper type, foil col-
our ink may not always be well applied.

The following types of foil colour printing are possible
depending on the number of ink cartridges used.

• Sing
Foil 
silve

• Mult
using

• Full 
ous f

Single foi

Single foi
Only the f
This meth
(including
be printed
printing ca
using does
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Requirements

P

Note:
 select a colour in the application
lour of the ink cartridge in the
characters and images in black is

s

il colour (gold or silver) plus the
, magenta, yellow, and black into
ers. The ink cartridges may be in-

your printer

 loading paper depends on the pa-
l feed mode for cardboard (thick
ards. For plain paper or laser pa-

e automatic feed mode.

river for printing

m the File menu to open the Print
 click Properties.

ment/Quality tab to bring to the

Type to an option appropriate to
 be printed.

ownload.
For single foil colour printing you will need the follow-
ing.

1.  Media

a Plain paper, laser paper, postcards, etc. can
be used as with normal colour printing.

2.  Ink cartridges

Use either one of the following ink cartridges.

a Gold Foil ink cartridge 

b Silver Foil ink cartridge 

The following ink cartridges are also necessary 
for undercoating.

a Cyan ink cartridge

b Magenta ink cartridge

c Yellow ink cartridge

d Black ink cartridge

repare the image to be printed

Use any application to create the image or document
you want to print, and prepare it as you would for nor-
mal printing.

It is not necessary to
that matches the co
printer. Leaving the 
acceptable.

Install ink cartridge

Install the desired fo
undercoat inks, cyan
the ink cartridge hold
stalled in any order.

Load the paper in 

The method used for
per type. Use manua
paper) and greeting c
per, you may also us

Set up the printer d

1. Select Print fro
dialog box, then

2. Click the Docu
front.

3. Set Document 
the document to
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, you can print with two foil colours or two
s plus black. You can use this method with
cations that support colour.

nts

 and ink cartridge requirements for multi foil
ting are the same as in the single foil colour
he only difference being that both gold and
ink cartridges must be used.

e image to be printed

pplication to create the image or document
o print. Then set the colours corresponding to
olour you want to use. For example, set the
e image that you want to print in gold foil to
 those of the image that you want to print in

to grey. When you want to print foil colours
 simultaneously, you must also specify the
ant to print in black.

f the colour and grayscale data is binarized
olour printing, gradation cannot be repre-

ownload.
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4. Set Media Type depending on the paper to be
used.

5. In Print Settings click the Use Spot Colours
check box so that the Spot Colours dialog box is
displayed.

6. In the Spot Colour Settings click the Use Foil
Colour(s) radio button.

7. Set Print Using to Single Ink.

8. Enabled ink cartridges among those installed in
the printer are displayed in Select Ink Car-
tridge(s). Click the radio button(s) of the ink car-
tridge(s) to be used. 

Note:
If bidirectional communication is not possible, all the
usable ink cartridges are displayed.

9. When you complete the setup, click OK to close
the dialog box.

10. Click OK in the Print dialog box to start printing.

Multi foil colour printings

Use the steps outlined below for foil colour printing us-
ing two foil colour ink cartridges. By associating each
foil colour with a colour (or colour component) in your

application
foil colour
most appli

Requireme

The media
colour prin
printing. T
silver foil 

Prepare th

Use any a
you want t
each foil c
parts of th
yellow and
silver foil 
and black
area you w

Note 1:
Since all o
in multi c
sented.
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Note 2: Note:
changing colour component set-
lication, refer to your software
nual. Depending on the applica-
y not print correctly even though

ere properly set in the application.
window before printing, and try
sing the setting to get the correct

s

ilver foil colour ink cartridges plus
rtridges listed in Requirements.
n be installed in any order.

your printer

e for cardboard (thick paper). For
aper, you can use automatic feed

river for printing

m the File menu to open the Print
 click Properties.

ment/Quality tab to bring to the

G

S

B

G

S

G

S

ownload.
White portions of data (R=G=B=100%) are not
printed.

In multi foil colour printing, indicate foil colours by se-
lecting colours in the application that most closely re-
semble the foil colours. Try to select colours that
resemble the colours listed in the tables below. In appli-
cations that do not have many colour choices, such as
word processors, closely related colours can be used.

• Colour compositions using RGB settings (n/255)

• Colour compositions using RGB settings (n/
100%)

For instructions on 
tings within an app
application User ma
tion, a foil colour ma
the colour settings w
Check the Preview 
increasing or decrea
foil colour to print.

Install ink cartridge

Install the gold and s
the undercoat ink ca
The ink cartridges ca

Load the paper in 

Use manual feed mod
plain paper or laser p
mode.

Set up the printer d

1. Select Print fro
dialog box, then

2. Click the Docu
front.

Foil Colour
Application colour used to indicate the foil 

colour

old Foil Yellow (or yellow/orange)

ilver Foil Grey

lack (normal) Normal black (R=G=B=0 or C=M=Y=0, K=100)

Foil Colour R G B

old Foil 225 160 0

ilver Foil 189 193 197

Foil Colour R G B

old Foil 88 63 0

ilver Foil 74 76 77
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 OK in the Print dialog box to start printing.

ous full colour and foil colour 

ing paragraphs describe how to print full
 foil colour simultaneously . This printing

fferentiates between foil colour and full col-
epending on their colour component. For this
is necessary to assign the correct colour to
 This printing method is used with applica-
allow the user to accurately specify colour
ts.

nts

taneous full colour and foil colour printing
eed the following.

ia

Plain paper, laser paper, postcards, etc. can
be used as with normal colour printing.

artridges

ollowing ink cartridges can be used for 
ltaneous full colour and foil colour printing.

Gold Foil ink cartridge

ownload.
Chapter 5 - Specialised Printing Operations

3. Set Document Type to an option appropriate to
the document to be printed.

4. Set Media Type depending on the paper used.

5. In Print Settings click Use Spot Colours check
box so that the Spot Colours dialog box is dis-
played.

6. In the Spot Colour Settings click the Use Foil
Colour(s) radio button.

7. Set Print Using to Multiple Inks.

8. Enabled ink cartridges among those installed in
the printer are displayed in Select Ink Car-
tridge(s). Click the radio button(s) of the ink car-
tridge(s) to be used. 

Note 1:
If bidirectional communication is not possible, all the
usable cartridges are displayed.

Note 2:
Even though you have set the colour of an area to a
desired colour in your application, the area will not be
printed if the corresponding ink cartridge has not
selected.

9. When you complete the setup, click OK to close
the dialog box.

10. Click

Simultane
printing

The follow
colour and
method di
our areas d
reason, it 
each area.
tions that 
componen

Requireme

For simul
you will n

1. Med

a

2. Ink c

The f
simu

a
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b Silver Foil ink cartridge

P

colours. Because of this, photographs and other data
olours may have areas that match
ations and print only partially in

rinting images that contain data
, it is best to print full colour plus
rlay mode

olour plus foil colour printing, in-
ilver foil colours by selecting the
r component. For characters of 32
t the following approximate col-

itions using RGB settings (n/255)

sitions using RGB settings (n/

tion colour used to indicate the foil 
colour

 yellow/orange)

G B

160 0

193 197

R G B

63 0

76 77

ownload.
c Cyan ink cartridge

d Magenta ink cartridge

e Yellow ink cartridge

f Black ink cartridge

g Finish II ink cartridge

h VPhoto Primer ink cartridge 

Note:
Only a maximum of seven ink cartridges can be
installed in the printer at any one time. Cyan,
Magenta, Yellow and Black cartridges must always be
installed. The Foil, Finish II and VPhoto Primer car-
tridges are optional.

repare the image to be printed

Create the data you want to print, then set the image ar-
eas to be printed in foil colours to colours that corre-
spond to the foil colours you want to use. For the
colours (and colour components) that correspond to
each foil colour, refer to the tables on page 5-12. 

Note:
There are a small range of colour component values
that will be interpreted by the printer as indicating foil

with many different c
the foil colour design
foil colour. When p
such as photographs
foil colour using Ove

In simultaneous full c
dicate the gold and s
corresponding colou
points or more, selec
ours.

• Colour compos

• Colour compo
100%)

Foil Colour
Applica

Gold Foil Yellow (or

Silver Foil Grey

Foil Colour R

Gold Foil 225

Silver Foil 189

Foil Colour

Gold Foil 88

Silver Foil 74
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 printer driver for printing

t Print from the File menu to open the Print
g box, then click Properties.

 the Document/Quality tab to bring to the
.

t Automatic, Photographs, or Graphics/
from the Document Type.

edia Type depending on the paper used.

e any other necessary changes to the settings.

int Settings click Use Spot Colours check
so that the Spot Colours dialog box is dis-
d.

ot Colour Settings click the Use Foil Col-
) radio button.

rint Using to Metallics & CMYK Inks.

led ink cartridges among those installed in
rinter are displayed in Select Ink Car-

e(s). Click the radio button(s) of the ink car-
e(s) to be used. 

gh you have set the colour of an area to your
lour in your application, the area will not be

ownload.
Chapter 5 - Specialised Printing Operations

Note 1:
Some applications make internal adjustment to pro-
duce the displayed colour components. In such cases,
the colour components cannot be restricted and there-
fore foil colours cannot be used. When using such an
application, use the Overlay mode.

Note 2:
There are a small range of colour component values
which are close to a foil colour. These colours will be
interpreted by the printer as indicating foil colours and
will be printed in the respective foil colour.

Install ink cartridges

Install all the ink cartridges specified in Requirements
into the ink cartridge holders, including VPhoto Primer
ink for undercoating. Simultaneous full colour plus foil
colour printing is possible by exchanging ink cartridges
when the corresponding message is displayed.

Load the paper in your printer

The method used for loading paper depends on the pa-
per type used. 

Set up the

1. Selec
dialo

2. Click
front

3. Selec
Text 

4. Set M

5. Mak

6. In Pr
box 
playe

7. In Sp
our(s

8. Set P

9. Enab
the p
tridg
tridg

Note 1:
Even thou
desired co

Download from Www.Somanuals.com. All Manuals Search And D



52 User’s Guide

printed if the corresponding ink cartridge has not been

ownload.
selected.

Note 2:
If a selected foil colour ink cartridge is not installed, a
warning message will be displayed. In this case,
exchange ink cartridges as indicated in the message.

10. When you complete the setup, click OK to close
the dialog box.

11. Click OK in the Print dialog box to start printing.
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 on overhead transparencies, use only OKI
sparency film.  Using other transparency

se damage to the printer.

e image to be printed

 text and graphics to be printed in your appli-
ke care to lay them out within the printing
overhead transparency film.

 cartridges

 ink cartridges listed above into the ink car-
ders. The ink cartridges may be installed in

verhead transparencies

the sheets before loading them into the
er to ensure they do not stick together.

 the sheets into the auto sheet feeder or man-
eed slot in the correct orientation. The cut
er at the end of the sheet should be first

ownload.
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Printing on overhead transparencies

The following paragraphs describe how to print full
colour graphic images and text on overhead transparen-
cies for presentations.

Requirements

For printing on overhead transparencies, you will need
the following.

1.  Media

a DP-5000 Overhead Projector Transparency
Film (A4).

2. Ink cartridges

The following ink  cartridges can be used.

a Cyan ink cartridge

b Magenta ink cartridge

c Yellow ink cartridge

d Black ink cartridge

e White ink cartridge

Caution:
When printing
DP-5000 tran
films may cau

Prepare th

Create the
cation. Ta
area of an 

Install ink

Install the
tridge hol
any order.

Load the o

1. Fan 
print

2. Load
ual f
corn
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located into the left side of the printer (when
viewed from the front).

S

5. Place the box with the installed separators into
the printer paper tray and align the edge of the

ntre cover (5) on the printer.

sparencies are printing they will
the separators, preventing them
p any completed transparencies

hen a transparency is completed it
gh the separators by the time the
s printing.

 driver for printing

m the File menu of your applica-
 dialog box appears, click Proper-

ment/Quality tab to bring to the

ment Type to the appropriate

ype to Transparency Film.

elect the required colour option.

plete the setup, click OK to close

 Print dialog box to start printing.

ownload.
3. To prevent jams remove the sheets immediately
after printing.

4. If the last sheet of film will not feed from the auto
sheet feeder, place a sheet of paper underneath it.

etting up transparency separators

Occasionally electrostatic build up may cause a sheet of
transparency film to attach itself to another. To prevent
this separator cards must be placed inside the transpar-
ency film box. To set up the transparency separators:

1. Cut along the two inner dotted lines (see Figure 1,
number 1) on the separator card. Discard the mid-
dle portion of the card.

2. Fold the two cards along the dotted line (2). The
folded angle should be less than 90 degrees.

3. Take the inner box of the transparency film and
insert it into the box cover (3).

4. Insert the separators into each side of the box
between outer cover and inner box (4). Make sure
the folded angle remains at less than 90 degrees.

box with the ce

6. When the tran
ride on top of 
from picking u
lying below. W
will drop throu
next sheet begin

Set up the printer

1. Select Print fro
tion.  When the
ties.

2. Click the Docu
front.

3. Set the Docu
option.

4. Set the Media T

5. In Print Mode s

6. When you com
the dialog box.

7. Click OK in the
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3 4

ownload.
Chapter 5 - Specialised Printing Operations

5

1

22
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Undercoating with VPhoto primer ink cartridge

R

C
O
w

P

e

ne VPhoto Primer ink cartridge is
rtridge holders.  The ink cartridge
y holder.

 your printer

 your printer and set up the feed
atic or manual.

 driver for printing

m the File menu to open the Print
 click Properties.

ment/Quality tab to bring to the

Type to an appropriate option.

e depending on the paper being

s click Use Spot Colours check
 Spot Colours dialog box is dis-

ownload.
The VPhoto Primer ink cartridge is used to print an un-
dercoat on paper prior to the main printing process.  Un-
dercoat fills any uneveness on the paper surface making
plain paper suitable for high quality colour printing.

equirements

For undercoating, you will need the following.

1. Media

Any plain photocopier paper can be used.

2. Ink cartridges

VPhoto Primer ink cartridge

aution:
verhead projector transparencies cannot be undercoated
ith VPhoto Primer ink.

repare the image to be undercoated

Use any application to create the image or document.
Highlight the area to be undercoated in grayscale.
White portions of data (R=G=B=100%) are not under-
coated.

Install ink cartridg

Make sure at least o
installed in the ink ca
can be installed in an

Load the paper in

Load the paper into
mode to either autom

Set up the printer

1. Select Print fro
dialog box, then

2. Click the Docu
front.

3. Set Document 

4. Set Media Typ
used.

5. In Print Setting
box so that the
played.
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6. In Spot Colour Settings click the Use Spot Col-
our(s) radio button.

7. Set Print Using to VPhoto Primer (Undercoat).

8. Click OK to close the dialog box.

9. Click the Paper tab to bring to the front, make all
necessary adjustments then click the Overlay
check box.

10. When you complete the setup, click OK to close
the dialog box.

11. Click OK in the Print dialog box to start printing.
Your document will be printed using VPhoto
Primer ink.

Note:
The Overlay function lets you leave a sheet in the
printer after a printing pass is complete, allowing you
can change cartridges and print addittonal colours on
the same page.

Printing on undercoat

After the printing process is complete, you can then
print your document onto the undercoated paper.
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 the front cover release button and gently
r the front cover.

n the inside of the printer using a soft brush
ush away dirt and dust.

ownload.
Chapter 6 - Maintenance

Chapter 6 - Maintenance

Cleaning the printer

We recommend that this printer be cleaned periodically
to ensure satisfactory long term operation.

WARNING
Make sure you unplug the printer before cleaning it.

Cleaning the main unit

Follow the cleaning steps described below.

1. Use a soft cloth to wipe the outside of the printer
to avoid dust and dirt build-up.

2. Push
lowe

3. Clea
to br
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Caution:
B
ca
co

C

C
D
th

C
D

1. Push the front cover release button and gently
lower the front cover.

ead (1) with a cotton swab dipped
lcohol. The print head may not
ne wipe so repeat several times.

n the platen (2). Wait until the
ting.

en

to clean the platen as described be-

ownload.
rush very gently around electrical components, and be
reful not to leave any brush hairs on or near these
mponents.

leaning the print head

Follow the steps below, using isopropyl alcohol and a
cotton swab.

aution 1:
o not use benzene, thinner, or other volatile materials, as
ey may damage the printer components.

aution 2:
o not get the inside of the printer wet.

2. Wipe the print h
in isopropyl a
come clean in o

Caution:
Avoid getting alcohol o
alcohol dries before prin

Cleaning the plat

Use cellophane tape 
low.

1

2
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ly peel off the tape.

at as necessary to remove dirt from the
n.

the feed roller

pyl alcohol and a cotton swab to clean the
 as described below.

nzene, thinner, or other volatile materials, as
age the printer components.

 inside of the printer wet.

printer must be initialised for cleaning the
roller. To initialise turn off the printer first,
press the power button to turn the printer on
.

 the front cover eject button and gently lower
ont cover.

 the ready/insert button to move the carriage
afe position.

ownload.
Chapter 6 - Maintenance

1. Press the front cover release button and gently
lower the front cover.

2. Gently apply the tape (1) to dirty spots on the
platen (2), and rub your finger over the tape.

Caution:
Do not touch or remove the white pad (3) on the left side of
the platen. Doing so may damage the printer.

3. Slow

4. Repe
plate

Cleaning 

Use isopro
feed roller

Caution 1:
Do not use be
they may dam

Caution 2:
Do not get the

1. The 
feed 
then 
again

2. Push
the fr

3. Press
to a s

1

3 2
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4. Wipe the feed roller (metal shaft roller) with a
cotton swab dipped in isopropyl alcohol. The

C
A
dr

Changing dye sub cleaning pads

good print quality, replace the or-
ng pad after printing 20 sheets of
d is enclosed in each new package

leaning pad, open the front cover,
left end of the cleaning pad while
t side of the pad, as shown in the

e cleaning pad) is not removable.

ownload.
feed roller may not come clean in one wipe, so
repeat several times.

aution:
void getting alcohol on the platen. Wait until the alcohol
ies before printing.

5. Press the ready/insert button to turn the feed roller
and wipe the roller with a cotton swab until clean.

6. Close the front cover after you have finished
cleaning the feed roller.

7. The printer will be ready for printing.

In order to maintain 
ange-coloured cleani
paper. A cleaning pa
of Dye Sub paper.

1. To remove the c
and pull on the 
holding the righ
figure.

Caution:
The white pad (next to th

Download from Www.Somanuals.com. All Manuals Search And D



English

63

ownload.
Chapter 6 - Maintenance

2. To fit a new cleaning pad, mount the pad on the
platen by locating the two lugs on the underside
of the pad into the holes on the platen. Push the
pad onto the platen to make sure it sits flat.

Caution:
Always fit a cleaning pad in the printer. Failure to do so
can cause the printer to malfunction.
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Installing Ink Cartridges’ in Chapter 2 - Ini-
etup.

e the front cover. The printer will now be
to resume operation.

ors

inter error occurs, the error light flashes and
essage dialogue box appears on your compu-
. To rectify printer errors;

k the error message on your computer's
n.  For a list of Error messages see Indicator
ts Summary in Chapter 1 - Introduction.

ssage dialogue box cannot be displayed if
r is not capable of bi-directional printing.

ownload.
Chapter 7 - Troubleshooting

Chapter 7 - Troubleshooting

Troubleshooting - general

Power failure while printing

With the front cover closed, turn the printer on. The
printer will initialise and eject the partially printed
page.

When the front cover has been opened before the print-
er is turned back on, perform the following.

1. If an ink cartridge (1) is on the carriage (2), press
on the middle of the cartridge, as shown below, to
ensure it is properly seated. Also, check that the
cartridges in the holders are correctly installed.

See ‘
tial S

2. Clos
able 

Printer err

When a pr
the error m
ter's screen

1. Chec
scree
Ligh

Caution:
The error me
your compute

A

1

2
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2. Fix the error to continue printing, or terminate
printing. For more information on fixing printer

R

P

P

C

Forced printing and clearing data

fer from the computer stops for
 seconds, and the ready light is
ss the ready/insert button to force
e data it has received so far.

ms

 clear a paper jam.

 power button to shut off the

 cover release button and gently
over.

 the release lever (1) and gently
med paper.

ownload.
errors see the rest of this Chapter. 

eady/insert button functions

The ready/insert button is used for a number of func-
tions, depending on the printer status. The functions
during normal printing are described below.

aper feed

To feed a single sheet, set the paper feed switch to po-
sition “M” while no data is being received from the
computer (i.e. ready light is on), load one sheet of paper
into the sheet feeder, and then press the ready/insert
button.

aper eject

If paper is already in the printer and no data is being re-
ceived (ready light is on), press the ready/insert button
to eject the paper.

ancelling an alarm

To cancel an alarm for anything other than a hardware
or mechanism error, press the ready/insert button after
the removing the cause of the alarm.

When the data trans
more than about 30
blinking quickly, pre
the printer to print th

Clearing paper ja

Follow these steps to

1. First, press the
power.

2. Press the front
open the front c

3. Press down on
pull out the jam
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Paper jams can be caused by a dirty platen. For
information on cleaning see ‘Cleaning the Platen’
in Chapter 6 - Maintaining the Printer.

4. Close the front cover.

5. Press the power button to turn on the power.

1
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Troubleshooting - Windows

P

C

patible computers, most typical
k.

 use a one-way interface with the
ooler is set for one-way interfac-

uter have a bi-directional port? Is
ctional?

 Plug & Play installation and bi-
rfacing with the printer are only
 computer supports bi-directional
nd you are using a bi-directional

r a DOS machine?

nes (AT compatibles) can use the
communication used with this

 limitations of using one-way
with this printer?

rors cannot be detected by the
ver.

ownload.
When problems occur during operation of the printer,
please check the following troubleshooting tips before
returning the printer for repair.

ower does not come on

1 Is the power cable disconnected?

Make sure the power cable is plugged into an out-
let as well as connected to the printer. After
checking the power cable, press the power button
to turn on the printer.

2 Is the printer plugged into an extension block or
power strip?

After turning on the extension block or power
strip, press the power button to turn on the
printer.

heck computer and printer communications

1 Are you using the proper printer cable?

To fully take advantage of the features of your
DP-5000 printer, you will need a bi-directional
printer port and a bi-directional printer cable.

With AT com
cables will wor

It is possible to
printer if the sp
ing.

2 Does your comp
the cable bi-dire

Windows 95/98
directional inte
possible if your
parallel ports a
cable.

3 Is your compute

All DOS machi
bi-directional 
printer.

4 What are the
communication 

a Printer er
printer dri
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re a paper jam?

ove the paper. If the paper is caught in the
rs, open the front cover, push down on the
se lever, and gently remove the paper. Make
there are no pieces of the paper left in the
er.

he settings in the application correct?

eck the printer settings in the application.

 printer driver correctly installed?

ll the DP-5000 printer driver from the Instal-
 Disc.

 cable disconnected?

n one of the followings occurs, it is possible
he cable is broken or disconnected.

The gauge in the Print dialogue box does
not progress.

The “Out of Paper” message appears repeat-
edly.

Replace the cable with a new one.

ownload.
Chapter 7 - Troubleshooting

b The printer driver cannot tell which ink car-
tridge is in which holder.

c To store all the print output, an enormous
amount of spool data (held in a temporary
file for printing) is generated during colour
multipage printing. As a result, the number
of sheets of paper that can be continuously
printed will be limited if there is insufficient
free space on the hard disk.

Printer does not print or stops while printing

1 Is the printer turned on?

Before printing make sure the printer is turned
on.

2 Is the front cover closed properly?

Make sure that the front cover is firmly closed.

3 Is the ‘ready’ light off?

Press the ready/insert button and make sure the
ready light comes on.

4 Is the interface cable correctly connected?

After connecting the cable tighten the fastening
screws and clamps to secure the cable, and make
sure no pressure is on the cable.

5 Is the

Rem
rolle
relea
sure 
print

6 Are t

Rech

7 Is the

Insta
lation

8 Is the

Whe
that t

a

b

c
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9 Are you using a printer selection switch or a printer
buffer?

cartridge. After replacing the ink cartridge, print-
ing will continue from where it left off.

ugh hard disk space?

requires work space on the hard
ints. Keep enough space open on
 printer to operate (after printing,
is released.)

disk have areas where reading or
liable?

s on the hard disk where reading
unreliable, sometimes a printing
r and printing will stop. Periodi-
lity like SCANDISK that comes
6.0 (or later) or Windows 95/98 to
oblems.

orted, or has gaps

ons separated from the head?

ng and reinstall all the ink car-
 any slack in the ribbons. If a par-
idge repeatedly causes problems,
k cartridge.

ownload.
With bi-directional interfaces, operation is some-
times unreliable when using printer switching
boxes or printer buffers. If you are using a printer
selection switching box or printer buffer, use one-
way communication.

10 Is your cable too long?

Do not use a cable that is longer than you need.
The signals become more unstable as the cable
gets longer.

11 Are you using the wrong ink cartridges?

Use only the recommended ink cartridges. Do not
use ink cartridges from other manufacturers.

12 Are the ink cartridges correctly installed?

Insert ink cartridges in the carriage with the iden-
tification markings (B side) face up. This applies
to all ink cartridges except the reversible types :
Econo Black and Finish II.

13 Is the ribbon on an ink cartridges used up?

When the ribbon in an ink cartridge has been
used up, black and silver stripes will be visible on
the ribbon. When these appear install a new ink

14 Do you have eno

The DP-5000 
disk when it pr
the disk for the
the work space 

15 Does the hard 
writing are unre

If there are area
or writing are 
error will occu
cally use a uti
with MS-DOS 
prevent these pr

Printing is light, dist

1 Has one of ribb

Stop the printi
tridges. Take up
ticular ink cartr
try a different in
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you printing images with sudden colour
tions or very bright colours?

ese situations, the overlap of different col-
of ink can degrade the quality of the image.
cing the amount of halftoning can reduce
ffect. Use a halftone option appropriate for
age.

you printing on envelopes, thermal paper, or
re cards?

ing is unreliable on envelopes and other sur-
 which have a non-uniform thickness. Print-
nd feeding of thermal paper is unreliable.
aper side of picture cards may be printed on
 surface is smooth and the card thickness is
mm (0.01") or less, but printing on the photo
is unreliable.

ou printing on the wrong side of the paper?

 both VPhoto Print Film and Dye Sublima-
Paper, printing should take place on the
y side.  Take care not to print on back of the
r, particularly with Dye Sublimation paper,
 using the Dye Sub ink cartridges as the rib-

 in the cartridges may break.

ownload.
Chapter 7 - Troubleshooting

2 Is the ink cartridge head dirty?

Clean the cartridge head by refering to Chapter 5,
Maintaining the Printer. The platen often gets
dirty at the same time as the head, so it is recom-
mended to also clean the platen.

3 Is the platen dirty?

Clean the platen by refering to Chapter 5, Main-
taining the Printer. If cleaning the head and the
platen does not work, contact the supplier from
where you purchased the printer.

4 Are you using the correct ink cartridge for the
chosen printing medium?

Use only OKI ink cartridges for the DP-5000
printer. When printing in colour on the glossy
side of a greeting card, use only metallic ink car-
tridges.

5 Are you printing on a rough or special surface (such
as overhead transparency film)?

Rough or specially treated surfaces may not allow
the ink to adhere well, resulting in gaps or distor-
tions. In such a case, use a halftone setting appro-
priate for the image.

6 Are 
varia

In th
ours 
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Colour printing is not working or is extremely 
s

manual for information and check the colour set-
tings.

any applications at one time?

ory is available for print process-
y take a long time or fail. Close as
ns as possible and try again.

ugh memory?

r images requires a lot of memory
tion and for the data. Sometimes
icient memory left for printing.
 computer has enough memory to
 images you are using.

ion fault errors occur.

n occur when there is insufficient
lour printing or when part of the
come corrupted. After decreasing

 print data or scanning the hard
g again.

 on the hard disk fragmented?

red for printing can increase dra-
 free space on the disk drive is
ented. Clean up your files and

 disk by periodically running a

ownload.
low

1 Are the ink cartridges for colour printing
installed?

Only the following ink cartridges are suitable for
colour printing:

a Yellow, cyan, magenta, and black ink car-
tridges

b Yellow, cyan, magenta, black, VPhoto
Primer and Finish II ink cartridges

2 Are the settings correct?

Colour printing is selected if Automatic, Photo-
graphs, or Graphics/Text is selected in Docu-
ment Type.

3 Do you have enough disk space?

Make sure there is enough space on your hard
disk, (the working space is released once printing
is finished.)

4 Is the application set for colour printing?  Does the
application support colour printing?

Some applications have colour printing enable/
disable settings. Some applications do not sup-
port colour printing. Refer to your computer User

5 Are you using m

When little mem
ing, printing ma
many applicatio

6 Do you have eno

Handling colou
for the applica
there is insuff
Make sure your
print the size of

7 General protect

These errors ca
memory for co
hard disk has be
the size of the
disk, try printin

8 Is the free space

The time requi
matically if the
extremely fragm
defragment the
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r cut end is placed at the top of the paper
.

re a paper jam?

r the paper jam. Sometimes a small piece of
ammed page will tear off and remain in the
er so that sheets will continue to jam after
age is removed. Remove any small remain-
ieces of paper.

 paper feed guide too narrow for the paper?

paper feed guide should hold the paper
ly enough so that it can feed easily.

re too much paper in the sheet feeder?

sheet feeder can hold up to 100 sheets of
 paper, any more than this may cause a paper

 paper feed switch positioned correctly for the
r feed method?

rint on plain paper using automatic feed
, set the paper feed switch to position “A”;
int in manual feed mode, set it to position

ownload.
Chapter 7 - Troubleshooting

utility like DEFRAG that comes with MS-DOS
6.0 (or later) or Windows 95/98.

Paper is not feeding correctly or not ejecting 
correctly from the sheet feeder

1 Are you using paper which is thicker or thinner
than recommended?

Use paper within the range 0.07 mm - 0.23 mm
(0.003" - 0.01").  For auto feeding use paper in
the range 0.07 mm - 0.1 mm (0.003" - 0.004").

2 Are you using poor quality paper?

Paper that is folded, ripped or has holes, such as
loose leaf binder or refill paper, can cause paper
jams and should not be used.

3 Are you using curled paper?

This will cause paper jams. The paper should be
curled the opposite way to flatten it out before it
is used.

4 Are you using paper with folded or cut corners?

This can cause problems since the paper position
sensor and paper length sensor do not work prop-
erly. Sheets with corner cuts, such as transparen-
cies and back print film, will work fine if the

corne
guide

5 Is the

Clea
the j
print
the p
ing p

6 Is the

The 
loose

7 Is the

The 
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jam.
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9 Is the cut corner in the correct position (for
transparencies and back print film)?

13 Have you loosened the paper sufficiently prior to
loading it into the sheet feeder?

iffled several times prior to being
 sheet feeder. If not, sheets of
 to one another and cause multiple
to the printer at the same time, or
isfeed.

l noises when the power is 
ror lights blink

riage packing material been

er 1, Introduction for details on
ng material.

 tape on the case been removed?

pieces of tape on the front of the
p protect the printer during ship-
ust be removed before using the

tridge become dislodged from the

cover and make sure the ink car-
ctly installed.

ownload.
When these sheets are inserted with the cut corner
incorrectly positioned, they may not feed cor-
rectly. Follow the instructions and insert the
sheets correctly.

10 Are you printing on envelopes, thermal paper, or
picture cards?

Correct printing and feeding of envelopes and
thermal paper cannot be guaranteed. The paper
side of picture cards can be used if the card is less
than 0.23 mm (0.01") thick and manual feed
mode is used. Printing on the photo side is unreli-
able.

11 Are you using home-made cards or thick cards?

Cards with thickness within the range of 0.07 mm
- 0.23 mm (0.003" - 0.01") can only be used in
manual feed mode.

12 Is there anything blocking the paper output slot
(such as a large pile of printed sheets)?

This can cause ejection or feed problems, remove
the blocking paper.

Paper must be r
loaded into the
paper may stick
sheets to feed in
other forms of m

Printer emits unusua
turned on, and the er

1 Has the car
removed?

Refer to Chapt
removing packi

2 Has the packing

There are two 
printer that hel
ping. These m
printer.

3 Has an ink car
carriage?

Open the front 
tridges are corre
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ou using the printer on a level surface?

rinter will not operate correctly on a slanted
ce. Place it on a level, stable surface.

e printer in a place where it is subject to
ment?

us movements such as bumps and vibrations
ause mechanical problems. Place the printer
 environment where it will not be subject to
ment.

 front cover properly closed?

printer will not operate correctly if the front
r is not closed properly. Close the front cover
ctly.

tems stacked on top of the printer?

printer may malfunction if items are stacked
p or to the side of the printer.  Remove any
uction on top or to the side of the printer.

es are not correctly recognised

e bar code on the ink cartridge dirty?

n the bar code.

ownload.
Chapter 7 - Troubleshooting

4 Is there paper caught between the platen and the
print head?

Remove the paper (for reference see ‘Cleaning
the Printer’, Chapter 5) .

5 “Missing ink cartridges” message appears. Are all
the necessary colours of ink cartridge installed in the
printer?

Colour printing requires that four colours of ink
cartridge (yellow, magenta, cyan, and black) are
installed with the OKI logo (B side) facing up.

6 Are you generating monochrome printing in
Automatic mode?

If Automatic is selected in Document Type, col-
our ink cartridges must be installed even when
printing monochrome. If you want to print using
only black ink, select Greyscale or Mono-
chrome Text.

Mechanism or cartridge change error

1 Are the ink cartridges correctly installed?

If an ink cartridge has become dislodged from the
holder, an ink cartridge change error will occur.
Open the front cover and reinstall the ink car-
tridge.

2 Are y
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surfa

3 Is th
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2 Is the ink cartridge installed in the holder with the
(A) side up?

P

2 Black is printed with black ink, but grey portions
are printed using four colours.

ng, greyscale intermediate colours
are printed using four colours. If
nt only in black ink, set the Docu-
ing in the Document/Quality tab
ogue box to Greyscale.

to adjust the image quality of
hout reducing character resolution.

ys print at the currently selected
 outline font is used). The image
graphs can be adjusted independ-
Halftone setting in the More Set-
box.

to be no difference between
tput using monochrome printing at
ages obtained by monochrome
dard’.

rome printing in Fine, only the
be printed at 1200 dpi. This is
ing the 600 dpi images. The qual-
phs, however, differs little from

obtained by monochrome printing

ownload.
Make sure the ink cartridges are placed in the
holder with the identification markings (B side)
facing up.

3 Has an ink cartridge for a different printer been
installed?

Ink cartridges made by other manufacturers will
not work. Use only ink cartridges recommended
by OKI.

rinting quality, hue, and resolution queries

1 Can all four colours of the colour inks be
combined for black and white printing?

If Darker Black is set in colour printing or if the
brightness and contrast settings are correct, 4-col-
our black is possible. To print only with black,
turn off Darker Black, and return the Image set-
ting under Image Settings to default.

For monochrome printing, select Greyscale
under Document Type.

In colour printi
(such as grey) 
you want to pri
ment Type sett
in the Print dial

3 I would like 
photographs wit

Characters alwa
resolution (if an
quality of photo
ently using the 
tings dialogue 

4 There seems 
photographic ou
‘Fine’ and im
printing at ‘Stan

When monoch
characters can 
done by smooth
ity of photogra
that of images 
at Standard.
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tones close to those obtained by printing on
white paper.

On dark-coloured paper, impressive finish-
ing may be obtained by using monochrome
printing with white ink.

r images in the same document look different.

e sure that you select the same media type
rint mode. The media type presets the most

ble settings for your document. If you
ge the media type or print mode, it will affect
rinted results.

er

 should I use white ink?

e ink can be used as follows:

As with foil ink, white ink is effective for
spot colour printing on dark-coloured paper.

White ink can provide an undercoat for full
colour printing on light-coloured or coarse-
surfaced paper. The white undercoat will
improve image quality and colour reproduc-
tion.

ownload.
Chapter 7 - Troubleshooting

5 When plain or other coarse-surfaced paper is
printed in colour, ink is missing from a number of
points on the image.

When paper with a coarse surface is used for full
colour printing, ink will be missing from certain
points where it was difficult to deposit. To correct
this, you can attempt the following.

a Set the Halftone setting in the More Set-
tings dialogue box to Standard Dither for
printing. The image will be coarse, but the
ink will transfer to the paper more reliably.

b If you have VPhoto Primer ink, the image
quality may be improved by providing an
undercoat.

6 When coloured paper is used for full colour
printing, the colours are not reproduced correctly.

Colour printing is based on the colours repro-
duced when ink is printed on white paper, so cor-
rect colours cannot be reproduced on coloured
paper. DP printers, however, can provide the fol-
lowing forms of printing even on coloured paper:

a On light-coloured paper, DP printers pro-
vide a white undercoat prior to colour print-
ing. This allows colours to be reproduced in

b

7 Colou

Mak
and p
suita
chan
the p

Ink and pap

1 How

Whit

a

b
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2 How should I use VPhoto Primer ink? 7 Can I use the Photo Overcoat cartridge for photo
realistic finishing?

 the Finish II cartridge.

 use a printer switcher.

ter switcher may not support bi-
munication, use a uni-directional
.

o use multiple printer ports for

r is AT-compatible, up to three
LPT3) can be used, as long as they
s.

inter on a network?

r can be used on a network, but
directional interface and when set
al communication.

eries

e the printer driver?

95/98, refer to ‘Installing the
in Chapter 3 for details.

ownload.
The VPhoto Primer ink prints an undercoat and
improves the print quality on most plain papers
by allowing you to print photo quality images at
2400 dpi using variable dots.

3 Is it OK to print using white ink on top of a full
colour image?

This can cause unsatisfactory results. Print the
white ink before using other ink colours.

4 For full colour printing and glossy finish, may I use
any type of paper?

We suggest using High Grade Paper for full col-
our printing and glossy finish. Using other types
of paper can produce a poor image. Although
using our VPhoto Primer can help make many
plain papers suitable for full-colour printing.

5 Must I use the special sheets when printing
transparencies?

Yes, OKI recommended inks do not adhere well
to normal transparency sheets.

6 Can I print on regular greeting cards?

Yes, using manual feed mode.

No. Always use

Connection method

1 I would like to

Since your prin
directional com
interface setting

2 I would like t
connections.

If the compute
ports (LPT1 to 
are parallel port

3 Can I use the pr

Yes, the printe
only with a uni
for unidirection

Other operational qu

1 How do I delet

For Windows 
Printer Driver’ 
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 can I not print correctly with page layout
gs?

e are application programs that allow you to
at a document composed of both orientations
ortrait and landscape. When printing such
ment with layout (more than 2 pages per
), it may not print properly.

 can I not print spot colour using the Metallics
YK option?

cannot print text larger than 32pt in spot col-
In some application programs, you cannot
 in spot colour if the text is rotated or
ped.

ownload.
Chapter 7 - Troubleshooting

2 When my display is set for 64,000 or 16,700,000
colours, I run out of memory when printing.

Windows runs out of memory when there are too
many display colours. Change to 256 colours
when printing. Changing the display mode does
not change the print results.

3 When I print from Notepad in Windows, the left
edge does not print.

This happens whenever you print from Notepad
at 600 dpi or more. Switch to 300 dpi or use a dif-
ferent application.

4 When I print many sheets continuously, small
vertical lines appear on the right side of the page.

When printing for long periods of time, the print
head retains heat, and ink can attach to the paper
in places other than just the printing area. After
printing 30 sheets of Letter/A4 sized pages in
monochrome or 8 Letter/A4 sheets in colour, let
the printer cool down before continuing printing.

5 How can I reduce or enlarge my document?

The printer driver software allows you to scale
printing. Specify your scaling factor (25 - 400%)
in the Reduce or Enlarge option of your printer
driver software.

6 Why
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Troubleshooting - Macintosh

P

D
o

ialogue box appears.

ler is not displayed.

he following methods can be used
nter driver:

Special menu, select Switch To
uble-click on the installer icon to
printer driver.

itch To Finder function is not
on the Special menu, select

o At Ease and check the Off
in At Ease settings. Restart your
and install the printer driver.

pear in the Chooser

X enabled?

GX is installed, disable it by fol-
ps:

ontrol Panel” from the Apple

xtensions Manager.

ownload.
When problems occur during printer operation, please
check the following troubleshooting tips before return-
ing the printer for repair.

ower does not come on

1 Is the power cord disconnected?

Make sure the power cord is plugged into an out-
let as well as connected to the printer. After
checking the power cable, push the power button
to turn on the printer.

2 Is the printer plugged into an extension block or
power strip?

After turning on the extension block or power
strip, press the power button on the printer.

uring installation a “File not found” error 
ccurs or the installer is not found

1 Is At Ease installed?

If you are using At Ease when you place the
Installation Disc  in the CD-ROM drive, (some of
the Performa series start up in At Ease), the fol-
lowing things may happen. 

a The alert d

b The instal

In these cases t
to install the pri

a From the 
Finder. Do
install the 

b If the Sw
available 
Switch T
checkbox 
computer 

The icon does not ap

1 Is QuickDraw G

If QuickDraw 
lowing these ste

a Select “C
menu.

b Open the E

Download from Www.Somanuals.com. All Manuals Search And D



English

81

e must have a unique device number. (If the
uter has more than one SCSI bus, then the
e number must only be unique for the bus
he printer is attached to.)

ou using a high impedance cable?

 high impedance cable for each device in the
 chain.

 cable too long?

ot use a cable that is longer than you need.
signals become more unstable as the cable
longer.

 printer turned on?

 sure the printer is turned on before using
hooser to select the printer.

 the printer and computer turned on in the
g order?

 the printer on before turning on the compu-

 front cover closed correctly?

e sure that the front cover is closed correctly.

ownload.
Chapter 7 - Troubleshooting

c Deselect QuickDraw GX in the list of items.

d Close the Extensions Manager, and restart
your Macintosh.

2 Is the printer driver installed?

Install the DP-5000 printer driver from the Instal-
lation Disc (CD-ROM).

The DP-5000 printer cannot be selected in 
Chooser

1 Are the SCSI cable and terminator correctly
connected?

Correctly connect the SCSI cable and terminator.
Make sure that the cable is not bent excessively.
Excessive bending of the cable may break the
wires inside.

2 Is the SCSI cable loose?

Make sure the SCSI cable connectors are firmly
attached at both ends using the fastening screws
or clasps.

3 Is the SCSI device number set correctly?

Make sure the SCSI device number for the printer
is not the same as that used by any other SCSI
device attached to the computer. Each SCSI

devic
comp
devic
that t

4 Are y

Use a
SCSI

5 Is the

Do n
The 
gets 

6 Is the

Make
the C

7 Were
wron

Turn
ter.
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9 Is the ready light off? 14 Is the device number set correctly?

CSI device number of the printer
 as that used by any other SCSI
 to the computer. Each SCSI
e a unique device number. (If the
ore than one SCSI bus, then the
must only be unique for the bus

is attached to.)

r connected?

e is a terminator connected to the
n the SCSI chain. If you are using
n internal terminator, make it the
n the SCSI chain.

 jam?

per. If the paper is caught in the
e front cover, push down on the
d gently remove the paper. Make
no pieces of paper left in the

in the application correct?

nter settings in the application.

ownload.
Press the ready/insert button and make sure that
the ready light comes on.

10 Are you using the wrong cartridges?

Use only OKI recommended cartridges in the
DP-5000 printer. Do not use cartridges from other
manufacturers.

11 Are the cartridges installed correctly?

Insert the cartridges in the holders with the identi-
fication markings (B side) face up.

12 Is the ribbon in one of the cartridges used up?

When the ribbon in a cartridge has been used up,
black and silver stripes will be visible on the rib-
bon. Install a new cartridge. After replacing the
cartridge printing will continue from where it left
off.

13 Is the SCSI cable correctly connected?

Make sure the cable is not bent excessively, and
secure it firmly at both ends with the fastening
screws or clasps.

Make sure the S
is not the same
device attached
device must hav
computer has m
device number 
that the printer 

15 Is the terminato

Make sure ther
last peripheral i
a device with a
last peripheral i

16 Is there a paper

Remove the pa
rollers, open th
release lever, an
sure there are 
printer.

17 Are the settings 

Recheck the pri
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ting is not working or is extremely 

the ink cartridges for colour printing
lled?

following ink cartridges are required for col-
rinting:

Yellow, cyan, magenta, and black ink car-
tridges

Yellow, cyan, magenta, black, VPhoto
Primer, and Finish II ink cartridges

he print settings correct?

e Print dialogue box, select Automatic, Pho-
phs or Graphics & Text from the Type
.

 free space on the hard disk fragmented?

time required for printing can increase dra-
ally if the free space on the disk is
mely fragmented. Clean up your files and
gment the disk by periodically using a
gment utility.

ownload.
Chapter 7 - Troubleshooting

18 Is the printer driver correctly installed?

Install the DP-5000 printer driver from the Instal-
lation Disc (CD-ROM).

19 Has the printer been selected using the Chooser?

From the Apple menu, select the Chooser and
make sure the printer and device number appear
correctly. Click on the printer name and SCSI#.
(The printer may not be selected correctly if you
do not click on the printer name.)

20 Do you have enough hard drive space?

The DP-5000 requires work space on the hard
disk when it prints. Keep enough space open on
the disk for the printer to operate. (After printing,
the work space is released.)

21 Does the hard disk have areas where reading or
writing are unreliable?

If there are areas on the hard disk where reading
or writing are unreliable, sometimes a printing
error will occur and printing will stop. Periodi-
cally use the Disk First Aid utility that comes
with your system software (or other commercial
disk checking utility) to prevent these problems.

Colour prin
slow
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4 Is enough memory allocated? port colour printing. Read the manual for the
application and check the colour settings.

any applications at one time?

le memory is available for print
ting may take a long time or fail.

 applications as possible and try

orted, or has gaps

e ribbons separated from the

g and reinstall all the cartridges.
ack in the ribbons. If a particular
edly causes problems, try a differ-

y or is there an obstruction on the

 by following the directions in
ything is stuck to the print head,

g careful not to damage the head.
 gets dirty at the same time as the
ecommended that you clean the
ning the head.

ownload.
Colour printing may not be possible if the mem-
ory allocated to the application is insufficient.
Allocate more memory to the application.

5 Are you using memory management tools or virtual
memory?

When you are using memory management tools
such as RAM Doubler or virtual memory, mem-
ory may not be correctly recognised for colour
printing.

If colour printing is not working, try disabling
these utilities and try again.

6 Do you have enough disk space?

Make sure there is enough empty space on your
hard disk. (The working space is released once
printing is finished.)

When there is just barely enough working space
left on the disk, printing may take much longer
than normal.

7 Is the application set for colour printing? Does the
application support colour printing?

Some applications have colour printing enable/
disable settings. Some applications do not sup-

8 Are you using m

When very litt
processing, prin
Close as many
again.

Printing is light, dist

1 Has one of th
head?

Stop the printin
Take up any sl
cartridge repeat
ent cartridge.

2 Is the head dirt
print head?

Clean the head
Chapter 5. If an
remove it, bein
The platen often
head, so it is r
platen after clea
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you printing on envelopes, thermal paper, or
re postcards?

ing is unreliable on envelopes and other sur-
 which have a non-uniform thickness. Print-
nd feeding of thermal paper is unreliable.
ack side of picture postcards may be printed

 the surface is smooth and the card thickness
23 mm (0.01") or less, but printing on the
 side is unreliable.

ou printing in colour on the glossy side of a
ing card?

glossy side of a greeting card can only be
ed on using metallic cartridges.

ou printing on the wrong side of the paper?

 both VPhoto Print Film and Dye Sub Paper,
ing should take place on the glossy side. Par-
rly with Dye Sub Paper, take care not to

 on back of the sheet while using Dye Sub
artridges. The ribbons in the cartridges may
.

ownload.
Chapter 7 - Troubleshooting

3 Is the platen dirty or is there an obstruction on the
platen?

Clean the platen by following the directions in
Chapter 5. If anything is stuck to the platen,
remove it, being careful not to damage the platen.

If cleaning the head and the platen does not work,
contact the supplier from where you purchased
the printer.

4 Are you using the correct cartridges for the chosen
printing medium?

Use only OKI cartridges for the DP-5000 printer.
When printing transparencies, use only recom-
mended Overhead Projector Transparency Film
(A4).

5 Are you printing images with many sudden colour
variations or very bright colours?

In these situations, the overlap of different col-
ours of ink can degrade the quality of the image.
Try changing the Halftone option in the Image
Settings dialogue box from Fine to Standard.
Use a Blends option appropriate for the image.
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pictu
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Paper is not feeding or ejecting correctly from 
th

5 Is the cut corner in the correct position? 

ets are inserted with the cut corner
itioned, they may not feed cor-

 guide too narrow for the paper?

d guide should hold the paper
 so that it can feed easily.

h paper in the sheet feeder?

er can hold up to 100 sheets of
30 transparencies, any more than
a paper jam.

 switch positioned correctly for the
od?

lain paper using automatic feed
aper feed switch to position “A”;
ual feed mode, set it to position

g on envelopes, thermal paper, or
s?

g and feeding of envelopes and
cannot be guaranteed. The back
ostcards can be used if the card is
m (0.01") thick and manual feed

ownload.
e sheet feeder

1 Are you using paper which is thicker or thinner
than recommended?

Use paper within the range 0.07 mm - 0.23 mm
(0.003" - 0.01"). For auto feeding use paper in the
range 0.07 mm - 0.1 mm (0.003" - 0.004").

2 Are you using poor quality paper?

Paper that is folded, ripped or has holes, such as
loose leaf binder or refill paper, can cause paper
jams and should not be used.

3 Are you using curled paper?

This will cause paper jams. The paper should be
curled the opposite way to flatten it out before it
is used.

4 Are you using paper with folded or cut corners?

This can cause problems since the paper position
sensor and paper length sensor do not work prop-
erly. Sheets with corner cuts, such as transparen-
cies and back print film, will work fine if the
corner cut end is placed at the top of the paper
guide.

When these she
incorrectly pos
rectly.

6 Is the paper feed

The paper fee
loosely enough

7 Is there too muc

The sheet feed
plain paper, or 
this may cause 

8 Is the paper feed
paper feed meth

To print on p
mode, set the p
to print in man
“M”.

9 Are you printin
picture postcard

Correct printin
thermal paper 
side of picture p
less than 0.23 m
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emits unusual noises when the power 
, and the error lights blink

the carriage packing material been
ved?

r to Chapter 1, Introduction for details on
ving packing material.

he packing tape been removed?

e are two pieces of tape on the front of the
er that help protect the printer during ship-
 Gently remove the tape before using the
er.

a cartridge become dislodged from the
idge holder?

 the front cover and make sure the cartridges
orrectly installed.

re a paper jam?

r a paper jam by refering to ‘Clearing Paper
’ in this Chapter.  Occasionally a small piece
per will tear off and remain in the printer. If
appens, hold the release lever down and use

ck piece of paper to remove the small piece
per.

ownload.
Chapter 7 - Troubleshooting

mode is used. Printing on the photo side is unreli-
able.

10 Are you using home-made cards or thick cards?

Cards with thickness within the range of 0.07 mm
- 0.23 mm (0.003" - 0.01") can be used in manual
feed mode.

11 Are there pages piled up near the output slot or in
the output paper tray?

When printed material obstructs the paper output
slot, the paper feed and paper output may not
work correctly.

12 Have you loosened the paper sufficiently prior to
loading it into the sheet feeder?

Paper must be riffled several times prior to being
loaded into the sheet feeder. If not, sheets of
paper may stick to one another and cause multiple
sheets to feed into the printer at the same time, or
other forms of misfeed.

The printer 
is turned on

1 Has 
remo

Refe
remo

2 Has t

Ther
print
ping.
print

3 Has 
cartr

Open
are c

4 Is the

Clea
Jams
of pa
this h
a thi
of pa
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A mechanism or cartridge change error occurred 6 Is there an obstruction in front of the paper output
slot?

utput slot is obstructed, paper
e printer can fold or bend and
r to malfunction. When printing,

t the paper output slot is unob-
at there is room for paper to be

t correctly recognised

 on the cartridge dirty?

de.

installed in the holder with the (A)

artridges are placed in the holder
fication markings (B side) facing

tridge for a different printer been

e by other manufacturers will not
 OKI recommended cartridges.

ownload.
1 Are the cartridges installed correctly?

If a cartridge has become dislodged from its
holder, a cartridge change error will occur. Open
the front cover and reinstall the cartridge.

2 Are you using the printer on a level surface?

The printer will not operate correctly on a slanted
surface. Place it on a level, stable surface.

3 Is the printer in a place where it is subject to
movement?

Various movements such as bumps and vibrations
can cause mechanical problems. Place the printer
in an environment where it will not be subject to
movement.

4 Is the front cover properly closed?

The printer will not operate correctly if the front
cover is not closed properly. Close the front cover
all the way.

5 Are items stacked on top of the printer?

The printer may malfunction if items are stacked
on top or to the side of the printer.  Remove any
obstruction on top or to the side of the printer.

If the paper o
ejected from th
cause the printe
make sure tha
structed and th
ejected.

Ink cartridges are no

1 Is the bar code

Clean the bar co

2 Is the cartridge 
side up?

Make sure the c
with the identi
up.

3 Has an ink car
installed?

Cartridges mad
work. Use only
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e seems to be no difference between
graphic output using monochrome printing set

ine and images obtained by monochrome
ing set to Standard.

 monochrome printing set to Fine, only the
cters can be printed at Fine. This is done by
thing the Standard images. The quality of
graphs, however, differs little from that of

es obtained by monochrome printing set to
ard.

 plain or other coarse-surfaced paper is
ed in colour, ink is missing from a number of
s on the image.

n paper with a coarse surface is used for full
r printing, ink will be missing from certain
s where it was difficult to deposit. To correct
you can attempt the following:

Set the Halftone setting in the Image Setting
dialogue to Standard for printing. The
image will be coarse, but the ink will trans-
fer to the paper more reliably.

If you have VPhoto Primer ink, the image
quality may be improved by providing an
undercoat.

ownload.
Chapter 7 - Troubleshooting

Printing quality, hue, and resolution queries

1 Can all four colours of the colour inks be
combined for black and white printing?

In colour printing mode, greyscale portions are
printed using a four-colour greyscale. Black char-
acters are also printed using a mixture of the four
colours, if brightness is adjusted. To print mono-
chrome portions in black only, adjust the bright-
ness to 0%. To subject the overall image to
monochrome printing, set the Type Settings to
Black & White.

2 Black is printed with black ink, but grey portions
are printed using four colours.

In colour printing, greyscale intermediate colours
(such as grey) are printed using four colours. If
you want to print only in black ink, set the Type
setting in the Print dialogue box to Greyscale.

3 I would like to adjust the image quality of
photographs without reducing character resolution.

Characters always print at the currently selected
resolution (if an outline font is used). The image
quality of photographs can be adjusted independ-
ently using the Halftone setting in the Image Set-
ting dialogue box.

4 Ther
photo
to F
print

With
chara
smoo
photo
imag
Stand

5 When
print
point

Whe
colou
point
this, 

a

b
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6 When coloured paper is used for full colour
printing, the colours are not reproduced correctly.

In

improve image quality and colour reproduc-
tion.

overhead transparencies using foil

ible, but the foil ink is not trans-

e Sub Overcoat cartridge for Glossy

 the Finish II cartridge.

 using the white ink on top of a full

 unsatisfactory results. Print the
e using other ink colours.

rinting and glossy finishing, may I
aper?

ng High Grade Paper for full col-
sing other types of paper can pro-
ge. Using our VPhoto Primer will
 plain papers suitable for full-col-

ownload.
Colour printing is based upon the ink being
printed on a white background, so correct colours
cannot be reproduced on coloured paper. DP
printers, however, can provide the following
forms of printing even on coloured paper.

a On light-coloured paper, DP printers pro-
vide a white undercoat prior to colour print-
ing. This allows colours to be reproduced in
tones close to those obtained by printing on
white paper.

b On dark-coloured paper, impressive finish-
ing may be obtained by using monochrome
printing with white ink.

k and paper

1 How should I use white ink?

White ink can be used as follows:

a As with foil ink, white ink is effective for
spot colour printing on dark-coloured paper.

b White ink can provide an undercoat for full
colour printing on light-coloured or coarse-
surfaced paper. The white undercoat will

2 Can I print on 
cartridges?

Printing is poss
parent.

3 Can I use the Dy
finishing?

No. Always use

4 Is it OK to print
colour image?

This can cause
white ink befor

5 For full colour p
use any type of p

We suggest usi
our printing. U
duce a poor ima
help make many
our printing.
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gue box. This value may be specified
een 25 and 400.

preview doesn’t change even though I change
eduction or enlargement in the Page Setup
gue box.

preview will not change size with different
tion or enlargement settings. Check the size

 printing to see that the changes took effect.

do I uninstall the printer driver?

ove the DP-5000 printer driver from the
nsions folder in the System Folder, and
ve the DP-5000 Preferences file from the
rences folder. If you have installed the
e Kit software, and you are not going to use

ith other applications, remove the Queue
itor and Queue Watcher files from the
nsions folder. Restart your computer.

this printer be connected to Windows and
ntosh computers simultaneously?

he parallel port and the SCSI port cannot be
 at the same time. Connect a Macintosh com-
 to the printer using the Macintosh interface
le, and connect a Windows computer with-
e module.

ownload.
Chapter 7 - Troubleshooting

Connection method

1 Can I connect multiple DP printers to a single
computer?

If different SCSI device numbers are used, multi-
ple printers can be connected to a single Macin-
tosh. Of course, simultaneous printing is not
possible.

2 Can I connect a single DP printer to multiple
computers?

No, the printer is not designed for this.

Other operational problems

1 Is this printer compatible with PostScript?

The DP-5000 printer uses QuickDraw. It is not
compatible with PostScript.

2 EPS files cannot be output clearly.

Since EPS files are data files for PostScript print-
ers, images at 72 dpi may be output from Quick-
Draw depending on the application.

3 Are enlargements and reductions possible?

Set either the enlargement or the reduction rate in
the Reduce or Enlarge setting in the Page Setup

dialo
betw

4 The 
the r
dialo

The 
reduc
after

5 How 

Rem
Exte
remo
Prefe
Queu
it w
Mon
Exte

6 Can 
Maci

No, t
used
puter
modu
out th
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7 Why can I not print correctly with page layout
settings?

ownload.
There are application programs that allow you to
format a document composed of both orientations
of portrait and landscape. When printing such
document with layout (more than 2 pages per
sheet), it may not print properly.
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46.2cm (width) x 30cm (depth) x 19.1cm (height)

18.2" x 11.8" x 7.5"  (approximate dimensions)

5.2 kg (11lbs. 8 oz.)

220-240 Vac 50/60Hz

Parallel, SCSI (optional), USB (optional)

250 million pulses/dots

printing;  10,000 cycles

51 dB Maximum

FCC Class B, UL, CSA and CE

Temperature:

10°C to 30°C (50° to 86°F) (for
m on o c hr om e o n  p l a i n  pa p e r ) ,
otherwise 15°C to 30°C. (59° to
86°F).

Humidity:
30% to 70% (without condensation or
freezing)

Temperature: 0°C to 35°C (32° to 95°)

Humidity:
50% to 70% (without condensation or
freezing)

OKI DP-5000 Photo Quality Colour Printer

ownload.
Chapter 8 - Specifications & Settings

Chapter 8 - Specifications & Settings

Table 1 details the general specifications for the OKI
DP-5000 printer.

Name OKI DP-5000 Photo Quality Colour Printer

Print head 240 dot

Printing speed
Plain paper: Equivalent to 240 cps (100 cps x 2.4 lines)
(When printing 10-cpi text)

Resolution Photo-Quality: 2400 dpi colour and greyscale

Standard:
1200 dpi greyscale / black & white;
600 dpi colour /  black & white /
greyscale

Dye Sub:
Continuous-tone colour 600 dpi
(optional)

Printing area 330mm x 215mm (8.5” x 13”) maximum

Pa p e r  f e e d
method

Friction feed

Paper width 99mm - 224mm (3.9” - 8.82”)

Pa p e r
thickness

0.67mm - 0.23mm (0.003” - 0.01”)

Print media

Photo-Quality:
VPhoto print film and paper (2400
dpi)

Standard:
Standard paper, laser-print paper,
overhead transparencies, (600 dpi)

D ye
Sublimation:

Optional

Dimensions

Weight

Power supply

Interface

Head life

Machine life

Noise

A ge n cy
approvals

O pe r a t i n g
environment

S to r ag e
environment

Name
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Options

D

g is No.6.

 7 is reserved for the Macintosh
r 0 is normally assigned to the
ive, if there is one. To be safe, use
 1 through 6.

O

O

O

O

O

OFF No. 5

OFF No. 6 (note 1)

OFF No. 7 (note 2)

1 2 3 4 SCSI No.

ownload.
• SCSI Interface for Macintosh
(Part No. 41065001)

• USB Interface Kit for iMac & Window 95/98®

 (Part No. 41065101 )

• Dye Sublimation Upgrade Kit (enables dye subli-
mation printing capability)
(Part No. 41064901)

IP switches

DIP switches are used to set the SCSI ID number.

The following summarises the settings for each SCSI
device number.

Note 1:
Factory default settin

Note 2:
SCSI device number
itself. Device numbe
internal hard disk dr
only device numbers

1 2 3 4 SCSI No.

FF OFF OFF OFF No. 0

N OFF OFF OFF No. 1

FF ON OFF OFF No. 2

N ON OFF OFF No. 3

FF OFF ON OFF No. 4

ON

OFF

1 2 3 4

ON OFF ON

OFF ON ON

ON ON ON
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board or thick paper

in the recommended range shown in Table 4
pending on the printing media, printing out-
ecommended area may cause malfunctions
e ink cartridge ribbon getting caught and

B C D E F

297mm
(11")

3 . 5m m
(0.134")

3 . 5 m m
(0.134")

1 5 . 2 m m
(0.6”min)

1 2m m
(0.47”min
)

D E F

12mm (0.47") 15.2mm (0.6”min) 12mm (0.47")

ownload.
Chapter 8 - Specifications & Settings

Printable area

Using card

Print with
below. De
side the r
such as th
breaking.

A

B

C D

E

F

A

A4
2 1 0m m
(8.5")

C

12mm (0.47")
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Available supplies

In

Print media

ation Upgrade kit is installed.

B

Y

M

C

E

G

S

W

V

F

D

D

D

D

ia Part Number

, A4+) 41067706

 A4) 41067701

ncy Film 41067703

eets, A4) * 41067705

ns Part Number

41065001

d Windows 98® 41065101

41064901

ownload.
k cartridges

* When Dye Sublimation Upgrade kit is installed.

* When Dye Sublim

Options

Ink Cartridges Part Number

lack ink cartridge 41067604

ellow ink cartridge 41067603

agenta ink cartridge 41067602

yan ink cartridge 41067601

cono Black ink cartridge 41067605

old Foil ink cartridge 41067608

ilver Foil ink cartridge 41067609

hite ink cartridge 41067610

Photo Primer cartridge 41067606

inish II cartridge 41067607

ye Sub Yellow ink cartridge * 41067614

ye Sub Magenta ink cartridge * 41067613

ye Sub Cyan ink cartridge * 41067612

ye Sub Overcoat ink cartridge * 41067611

Print med

High Grade Paper (100 sheets

VPhoto Print Film (20 sheets,

Overhead Projector Transpare
(30 sheets, A4)

Dye Sublimation Paper (20 sh

Available optio

SCSI Interface for Macintosh

USB Interface Kit for iMac an

Dye Sublimation Upgrade Kit
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quirements

e iMac computer, Mac OS 8.1 with iMac
te 1.0 or later.

ompatible computer with USB port, Win-
 98.

n for iMac

the OKI USB Interface Kit to enable you to
ur DP-5000 printer with an Apple iMac, fol-
steps:

 computer and printer are turned off before
e USB printer cable.

ect the USB interface cable (1) to the paral-
nnector (2) on the printer.

ownload.
Appendix A - Optional Devices

Appendix A - Optional Devices

USB interface kit

The OKI USB Interface Kit enables you to use your
OKI DP-5000 Series printer with an Apple® iMac™ or
with a Windows 95/98® computer that has a USB port.

Important Note 1:
DO NOT unplug the USB interface cable while print-
ing.  If you do so you must restart your computer
before re-commencing printing.

Important Note 2:
The OKI USB interface cable works only with the des-
ignated OKI DP-5000 printer.

Important Note 3:
If your iMac computer is running Mac OS 8.1 you must
install the iMac update 1.0 software.  This upgrade is
not included on the OKI CD-ROM but can be down-
loaded, free of charge, from the Apple Web site. Please
note that you do not need to install this update with
Mac OS 8.5 or greater.

System re

• Appl
Upda

• PC c
dows

Installatio

To install 
operate yo
low these 

Caution:
Make sure the
you connect th

1. Conn
lel co
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ia USB hub

ownload.
4

Connect directly to your iMac Connect to your iMac v

6

1 5

1

2

1

3
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OKI USB printer

 that the USB interface cable is properly con-
 your printer is turned on.

t Chooser from the menu and click the DP-
 Series icon.

o Select a USB printer and select printer
red. 

e than one OKI printer is connected to the
, each printer will be assigned a separate
number (USB #1, USB #2, and so on).  

u installed the Queue Kit software, you can
ackground Printing.  Select the On button

able Background Printing.

e the Chooser.  Click OK to confirm you have
ged your current printer.

 you are ready for printing.  Refer to your
's Guide on the OKI Installation Disc for the
er driver settings.

ownload.
Appendix A - Optional Devices

2. Connect the other end of the USB cable (3) to an
available USB port (4) on the side of the iMac, or
on a USB hub (5).

a To connect the USB cable directly to the
iMac, open the port door (6) on the side of
the iMac, and with the three-pronged USB
icon facing up, plug the cable into the USB
port.

b To connect the USB cable to a USB hub,
plug the cable into the hub as shown below.
The USB hub itself can be connected to a
free USB port on the side of the iMac or on
the iMac keyboard.

Caution:
Do not plug the USB cable directly into the iMac
keyboard.  The USB port on the keyboard does not supply
its own power, so the combined current drain of the printer
and the keyboard might exceed USB specifications.

3. Turn on the printer (and the USB hub, if con-
nected), and then turn on the iMac computer.

4. Open the ‘English’ folder, and then double-click
on the Install OKI DP-5000 icon.

5. Follow the instructions on-screen to complete the
installation.

Using the 

Make sure
nected and

1. Selec
5000

2. Go t
requi

Note:
When mor
USB port
USB port 

3. If yo
use B
to en

4. Clos
chan

5. Now
User
print
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Installing for Windows 98

D

In

WARNING
ter and printer are turned off 

ct the USB interface cable.

B interface cable (1) to the paral-
) on the printer.

her end of the USB cable to an
ort on your computer.  Be sure to

ector on the USB cable to match
n your computer.

he printer, and then turn on the

nform you that it has detected new
 Cable) and the Add New Hard-

ill appear on screen.

ownload.
0

To install the OKI USB Interface Kit to enable you to
operate your DP-5000 printer with a Windows 98 com-
puter, follow these steps:

Note:
You must delete any previously installed OKI DP
Series printer driver prior to installing the USB printer
driver.  The new OKI printer driver enables you to
print using the USB interface cable, as well as the par-
allel printer cable.

eleting the OKI printer driver

1. Choose Settings from the Start menu, and then
select Printers. 

2. In the Printers window that appears, right-click
the OKI DP-5000 Series printer icon and then
select Delete from the menu. Click Yes to delete
the printer driver.

stalling the USB printer driver

1. If you haven’t already set up your printer, please
do so by following the instructions included with
the printer.

Make sure the compu
before you conne

2. Connect the US
lel connector (2

3. Connect the ot
available USB p
orient the conn
the connector o

4. Now turn on t
computer.

5. Windows will i
hardware (USB
ware Wizard w

1

2
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 will launch an installation program for the
er driver. Follow the instructions onscreen to
lete the installation

indows prompts you to restart your compu-
lick Yes.

ooting for USB interface kit

USB printer cannot be selected in the

ck the following:

e sure that the USB interface cable is prop-
connected to the printer and iMac computer,
the printer is turned on.  Then restart your
.

 sure that you have installed the iMac
te 1.0, if your iMac was running Mac OS

ownload.
Appendix A - Optional Devices

6. Place the OKI USB Setup Disc in your CD-ROM
drive, and click Next. In the next window that
appears, click Next to continue.

7. Select CD-ROM drive and Specify a location

from the Add New Hardware Wizard, and then
click Browse... button to select the folder
D:\Drivers\USB\English on the OKI Setup disc
(Where D: is the letter of your CDROM drive).
Click Next to continue.

8. In the next window that appears, click Next to
continue.

9. When the installation is complete, Windows
prompts you that it has finished installing the
software for the DF USB to LPT Cable.  Click
Finish.

10. Windows will now inform you that it has detected
new hardware (OKI DP-5000 printer) and the
Add New Hardware Wizard will appear. Click
Next.

11. In the next window that appears, click Next to
continue.

12. Select CD-ROM drive and Specify a location
from the Add New Hardware Wizard, and then
click Browse... button to select the CDROM
Drive where the OKI installation CD is located.

This
print
comp

13. If W
ter, c

Troublesh

iMac

Q1 The 
Chooser

Please che

1. Mak
erly 
and 
iMac

2. Make
Upda
8.1.
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Windows 98

Q
P
c

f Click OK to remove the Unknown Device
from your system, and then insert the USB

able to your computer.

son your first installation attempt
 try the following procedure.

e USB interface cable from your

OKI DP-5000 Setup Disc in your
 drive. From the Windows Start
ose Run. In the dialog box that
type the following: D:\driv-

nglish\MDULPTUN.EXE (Where
tter of your CDROM drive)

rm Uninstall window will appear.
 to uninstall the USB port monitor.

 Windows prompts you to restart
uter, click Yes.

eed from Step 4 of the ‘Installing
rinter Driver’ section.

ownload.
2

1 The Add New Hardware Wizard (USB
rinter) does not appear when the USB interface
able is connected.

Please check the following:

1. Make sure that the USB interface cable is prop-
erly connected to your printer and to your PC,
and the printer is turned on.

2. Make sure that the ‘Unknown Devices’ is not
listed in the Device Manager section of System
Properties.  To check this, follow these steps:

a Right-click My Computer and select Prop-
erties.

b In the System Properties window that
appears, select the Device Manager tab.

c Click View devices by type to display all
installed devices.

d If ‘Other devices’ exists, you need to delete
it.

e Double-click Other devices to view details,
click Unknown Device, and then click
Remove button.

interface c

3. If for some rea
is unsuccessful,

a Unplug th
computer.

b Place the 
CD-ROM
menu, cho
appears, 
ers\usb\E
D: is the le

c The Confi
Click Yes

d When the
your comp

e Now proc
the  USB P
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 do I delete the USB printer driver?

t to remove the OKI USB printer driver, fol-
ese steps:

r to ‘Deleting the OKI printer driver’ on page
and follow steps 1 to 4.

 the OKI DP-5000 Setup Disc in your CD-
 drive. From the Windows Start menu,

se Run. In the dialog box that appears, type
ollowing: D:\drivers\usb\English\MDULP-
.EXE (where D is the letter of your CDROM
)

 the OKI DP-5000 Setup Disc in your CD-
 drive, and double-click the USB_Setup
OM drive to open it, then double-click the

LPTUN.EXE icon.

Confirm Uninstall window will appear.
 Yes to uninstall the USB port monitor.

n the Windows prompts you to restart yout
uter, click Yes.

ownload.
Appendix A - Optional Devices

Q2 The Add New Hardware Wizard (OKI
printer) does not appear, after the MD USB to LPT
Cable software installation is complete

You can continue to install the OKI USB printer driver.
Follow these steps:

1. Make sure that the USB interface cable is prop-
erly connected to the printer’s parallel connec-
tion, and the printer is turned on.

2. If you are installing the standard printer driver,
please refer to the installation instructions in
Chapter 3, page 3-2 "Installing printer software
from CD".
If you are installing the Dye Sublimation printer
driver, please refer to the installation instructions
in page A-8 of this Appendix.

Q3 The ‘Printer to the following port:’ in
Printer’s Properties displays ‘MDULPT1: (USB
Port Not Connected)’ or ‘MDULPT1: (Unknown
USB Printer)’. 

1. Check that the USB interface cable is properly
connected to the parallel connector of your
printer and your computer’s USB port, also check
the printer is turned on. Then restart your compu-
ter.

Q4 How

If you wan
low the th

1. Refe
A-3  

2. Place
ROM
choo
the f
TUN
drive

3. Place
ROM
CD-R
MDU

4. The 
Click

5. Whe
comp
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Dye sublimation upgrade kit 

In

Macintosh remove SCSI interface
e back of the printer to reveal the

ector just to the right of the printer

nic key (1) from the Upgrade Kit
ry connector (2) with the notched
ey on top, as shown below.  The
fits one way.

rinter cable.

er with standard ink cartridges
a, yellow, and black). DO NOT
 dye sublimation ink cartridges at

ter.

1

ownload.
4

The Dye Sublimation Upgrade Kit enables your OKI
DP-5000 to print true continuous-tone images, without
dots, through the magic of dye sublimation technology.
The upgrade itself is as simple as plugging in the spe-
cial electronic key and pressing a button. At the same
time, you lose none of the other features of the DP-
5000, and you can still print with other DP-5000 supply
inks anytime you want.

stalling the upgrade

To install the DP-5000 Dye Sublimation Upgrade Kit
for a Windows PC (parallel port connection), an Apple
iMac (USB port connection) or a Macintosh (SCSI in-
terface module) follow these steps:

1. Turn off the computer and printer, and then dis-
connect the printer cable (or SCSI cable for the
Macintosh) and power cord from the printer.

2. Remove the rectangular plastic connector cover
located to the right of the printer connector on the
back of the printer. Locate the black tab at the
bottom of the connector cover, pull it up and twist
it until it breaks free, revealing the accessory con-
nector beneath. 

3. If using Apple 
module from th
accessory conn
connector.

4. Plug the electro
into the accesso
corner of the k
connector only 

5. Reconnect the p

6. Load the print
(cyan, magent
load the special
this time.

7. Turn on the prin

2
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le click on My Computer and open the
ers folder.

le-click on the Add Printer icon. This starts
dd Printer Wizard window.

n requested to choose the manufacturer and
 of your printer, click Have Disk… and navi-

 to the CD-ROM drive. In the CD-ROM
tory select ‘D:\driver\dyesub\English’
r, and then double-click the win95.inf file.

w the instructions onscreen to complete the
llation of the driver.

the port monitor for Windows 

llation applies only to users who have not
stalled the standard DP-5000 driver. 

e purchased the USB upgrade kit, and have
ed the USB cable software, then please refer
ng the USB Printer Driver’, steps 1 to 9 on

the Port Monitor:

indows 95/98, choose Run... from the Start

.

ownload.
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8. Press and hold the ready/insert button until the
printer lights begin to flash (about three seconds),
and then release the button. The printer now
prints a test page that gives the product name as
DP-5000P and includes “Dye-Sublimation Print-
ing” on the printed list of features.

9. Turn off the printer. If using an Apple Macintosh
reinstall the SCSI interface module, and recon-
nect the SCSI cable.

Installing the printer software

There are 2 steps to be made before installing the Dye
Sublimation printer software for Windows 95/98:

• The Dye Sublimation Printer Driver must be
installed.

• The Port Monitor must be installed.

Note:
The installation of the Port Monitor is only necessary if
you have not already installed the standard DP-5000
driver. If you have already installed the driver, then the
Port Monitor will automatically  be installed.

1. Insert the OKI DP-5000 installation disk into
your CD-ROM drive. If a driver installation win-
dow appears on screen, close it.

2. Doub
Print

3. Doub
the A

4. Whe
make
gate
direc
folde

5. Follo
insta

Installing 
95/98

Note:
This insta
already in

If you hav
not install
to ‘Installi
page A-4.

To install 

1. In W
menu
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2. In the window that appears type; D:\Drivers\Mon-
itor\English\Monitor.exe

In

1. Insert the OKI DP-5000 installation disk into
your CD-ROM drive.

ish’ folder, and then double-click
KI DP-5000 icon.

uctions on-screen to complete the

ownload.
6

3. Click OK.

4. The Port Monitor Installer window appears. Click
Install.

5. In Windows 95/98, choose Settings from the
Start menu. Then select Printers.

6. In the Printers window that appears, right-click
the OKI DP-5000 icon. Select Properties.

7. Click on the Details tab.

8. Select OKI_LPTx (OKI DP-5000 Printer Port) in
the Print to the following port: menu. (Where x
is the LPT port number you selected.)

9. Click OK to close the Properties window.

stalling the printer driver for Macintosh

To install the printer driver software for Macintosh, fol-
low these steps:

Note:
If you have already installed the printer driver soft-
ware for your OKI DP-5000 printer (without Dye Sub-
limation Upgrade), you do not need to install any
additional software.

2. Open the ‘Engl
on the Install O

3. Follow the instr
installation.
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 tab on the bottom of the cover, pull it up,
wist it until it breaks free.

e the SCSI interface module (1) so that the
n top of the module slips under the top edge
e computer printer cable slot. The top edge
e module should rest against the frame of the
er.

ly press the bottom of the module until it
s into place.

1

1
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Connecting SCSI interface for Macintosh

When your printer has been positioned in a suitable lo-
cation, you can connect it to your Macintosh computer
with a SCSI interface and to a suitable AC power
source with the power cable.

Connecting the Macintosh SCSI interface 
module

When using your printer with a Macintosh computer,
the printer must be connected to the computer via a
SCSI interface module. To install the SCSI interface
module on your printer, follow these steps:

1. Before connecting the SCSI interface module
turn off the computer and printer, and disconnect
the printer power cord. 

Note:
The SCSI interface module cannot be connected or dis-
connected until the printer power cord has been
removed.

2. Remove the rectangular plastic connector cover
(1) located to the right of the printer port on the
back of the printer. To remove the cover locate the

black
and t

3. Angl
tab o
of th
of th
print

4. Gent
click
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Removing the SCSI interface module

C

C
Po
th
di
m

Caution 2:
gh-impedance SCSI cable and an

ables can cause the printer to

able (1) to the printer and to the
 the printer cable to the connectors
 the computer.

 terminator (3) to the printer if the 
st peripheral on the SCSI chain.

1

2

ownload.
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1. Turn off the power to your printer, computer, and
all SCSI devices connected. Remove the power
cable from the wall socket and the printer. 

2. To disconnect the SCSI interface module (1) gen-
tly pull the plastic handle (2) at the bottom of the
module to release the catch and lift the module
away from the printer.

onnecting the printer to your computer

aution 1:
wer to the printer and computer must be turned off and
e power cables unplugged before connecting or
sconnecting the printer cable. Otherwise damage or
alfunction may result.

For best results use a hi
active terminator.

Caution 3:
Using other types of c
malfunction.

Connect the SCSI c
computer (2). Secure
on the printer and on

Note:
Always attach a
printer is the la

2

1

3

4
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Checking the SCSI device number

Make sure the device number for the printer is set cor-
rectly, the printer device number is set to 6 at the facto-
ry.  Each SCSI device connected to the computer must
have a unique SCSI device number. If two devices have
the same device number, they will not work properly. 

To change the device number, move the DIP switches
(4) next to the connector. For information on DIP
switch settings, refer to ‘Specifications and Settings’ in
Chapter 8.

Power supply connection

Connect your printer to a power supply as described in
Chapter 2, Initial Setup.
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